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Was Sie sehen, kann unterschiedlich sein

Illustrationen
LibreOffice läuft auf Windows, Linux, und Mac OS X. Jedes dieser Betriebssysteme hat mehrere

Versionen und können durch den Anwender individuell eingerichtet werden (Schriftarten, Farben, 
Themen, Fenster Manager). Die Illustrationen in dieser Anleitung wurden von einer Vielfalt von 
Computern und Betriebssysteme übernommen. Deshalb werden einige Illustrationen nicht genau 
aussehen, wie was Sie auf Ihrem Computer-Bildschirm sehen.

Auch einige Dialoge können infolge der ausgewählten Einstellungen in LibreOffice unterschied-
lich sein. Sie können entweder Dialoge von Ihrem Computersystem verwenden (standardmäßig) 
oder von LibreOffice bereitgestellte Dialoge. Um die Verwendung der LibreOffice Dialoge zu än-
dern:

1) Auf Linux und Windows Betriebssysteme, gehen Sie zu Extras > Optionen > LibreOffice 
> Allgemein auf der Hauptmenüleiste, um den Dialog für allgemeine Optionen zu öffnen.

2) Auf einem MAC-Betriebssystem, gehen Sie zu LibreOffice > Voreinstellungen > Allge-
mein auf der Hauptmenüleiste, um den Dialog für allgemeine Optionen zu öffnen.

Wählen Sie LibreOffice Dialoge verwenden in Öffnen/Speichern Dialoge und, nur in Linux 
und Mac OS X Betriebssysteme, gehen Sie in Druck-Dialoge, um die LibreOffice Dialoge 
auf Ihrem Computer-Bildschirm anzuzeigen.

3) Klicken Sie auf OK, um Ihre Einstellungen zu speichern und den Dialog zu schließen.

Symbole
Die Symbole, die angewendet werden, um einige der vielen verfügbaren Werkzeuge in 

LibreOffice zu veranschaulichen, können von denen, die in dieser Anleitung dargestellt werden, ab-
weichen. Die Symbole in dieser Anleitung wurden aus einer LibreOffice Installation übernommen, 
die für die Anzeige der Galaxy Symbol Reihe eingestellt war.

Wenn Sie es wünschen, können Sie Ihr LibreOffice Softwarepaket für die Anzeige der Galaxy 
Symbole wie folgt ändern:

1) Auf Linux und Windows Betriebssysteme, gehen zu Extras > Optionen > LibreOffice > 
Ansicht auf der Hauptmenüleiste, um den Dialog für die Ansicht Optionen zu öffnen.

Auf einem MAC-Betriebssystem, gehen Sie zu LibreOffice > Einstellungen > Ansicht auf 
der Hauptmenüleiste, um den Dialog für die Ansicht Optionen zu öffnen.

2) In Ansicht > Symbolgröße und Symbolstil wählen Sie von den verfügbaren Optionen Gala-
xie in der Auswahlliste.

3) Klicken Sie auf OK, um Ihre Einstellungen zu speichern und den Dialog zu schließen.

Hinweis

Einige Linux-Betriebssysteme, zum Beispiel Ubuntu, gehören als Teil der LibreOffice 
Installation und beinhalten nicht die Symbole der Galaxy Reihe. Sie können den Ga-
laxy-Symbol-Satz von den Software-Repositorien Ihres Linux-Betriebssystems herun-
terladen.



Die LibreOffice Verwendung auf einem MAC

Einige Tastatureingaben und Menüpunkte auf einem MAC unterscheiden sich von solchen in 
Windows und Linux. Die Tabelle unten gibt einige allgemeine Ersetzungen für die Instruktionen in 
diesem Abschnitt. Eine ausführlichere Liste finden Sie unter der Anwendungen Hilfe.

Windows oder Li-
nux

Mac gleichwertig Effekt

Extras > Optionen 
Menüauswahl

LibreOffice > Voreinstellungen
Der Zugriff auf Einrichtungsoptionen

Rechtsklick Kontrolle+Klick oder Rechtsklick 
je nach Computer Einrichtung

Öffnet das Kontext-Menü

Ctrl (Strg) ⌘ (Befehl) Benutzt mit anderen Tasten

F5 Umschalttaste+⌘+F5 Öffnet den Navigator

F11 ⌘+T Öffnet das Vorlagen- & Formatierungs-Fens-
ter
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Einführung

Sie können Daten in Calc auf verschiedene Weise eingeben: mit der Tastatur, Ziehen und Able-
gen mit der Maus, dem Füll-Werkzeug und Auswahllisten. Calc bietet auch die Möglichkeit, Infor-
mationen gleichzeitig in mehrere Tabellen aus der gleichen Tabellenkalkulation einzugeben. Nach 
der Dateneingabe, können Sie diese anschließend formatieren und auf verschiedene Arten anzei-
gen.

Die Anwendung der Tastatur

Die meisten Dateneinträge in Calc können mit der Tastatur erreicht werden.

Zahlen
Klicken Sie in die Zelle und geben die Zahlen mit den Zahlentasten ein – entweder auf der 

Haupttastatur oder auf der Zehnertastatur.

Negative Zahlen

Um eine negative Zahl einzugeben, schreiben Sie entweder ein Minus (-) Zeichen vor die Zahl 
oder schließen die Zahl in Klammern ein () - zum Beispiel (1234). Das Resultat aus beiden Metho-
den des Eintrags wird dasselbe sein – zum Beispiel -1234.

Führende Nullen

Um eine Mindestanzahl von Zeichen in einer Zelle beizubehalten, um diese bei der Eingabe von 
Zahlen und dem Zahlenformat zu erhalten, müssen zum Beispiel bei 1234 und 0012, führende Nul-
len wie folgt hinzugefügt werden:

1) In der ausgewählten Zelle, klicken Sie mit der rechten Maustaste auf die Zelle und wählen 
Zellen formatieren aus dem Kontext-Menü, oder Sie gehen auf Format > Zellen in der 
Menüleiste, bzw. wenden Sie die Tastenkombination Strg+1 an, um den Zellen formatie-
ren Dialog zu öffnen (Abbildung 21).

Die Anwendung der Tastatur Seite 8
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2) Stellen Sie sicher, dass die Zahlen-Seite ausgewählt ist, dann wählen Sie Zahl in der Kate-
gorieliste aus.

3) In Optionen > “Führende Nullen“, geben Sie die Mindestanzahl der erforderlichen Zei-
chen ein. Zum Beispiel, für vier Zeichen, geben Sie 4 ein. Jede Zahl, weniger als vier Zei-
chen, werden führende Nullen hinzugefügt haben, zum Beispiel 12 wird 0012.

4) Klicken Sie auf OK. Die eingegebene Zahl behält sein Zahlenformat und auch jede verwen-
dete Formel in der Tabellenkalkulation, wird den Eintrag als eine Zahl in der Formelfunktio-
nen behandeln.

Wenn eine Zahl mit führenden Nullen eingegeben ist, zum Beispiel 01481, wird standardmäßig 
Calc die führende 0 nicht automatisch anzeigen. Um führende Nullen in einer Zahl zu erhalten:

1) Schreiben Sie vor die Zahl ein Apostroph (’), zum Beispiel ’01481.

2) Bewegen Sie die Zellenschreibmarke in eine andere Zelle. Der Apostroph ist automatisch 
entfernt, die führenden Nullen bleiben erhalten und die Zahl wird nach links ausgerichtet als
Text konvertiert.

Zahlen als Text

Zahlen können auch wie folgt, in Text umgewandelt werden:

1) In der ausgewählten Zelle, klicken Sie mit der rechten Maustaste auf die Zelle und wählen 
aus dem Kontext-Menü Zellen formatieren, oder Sie gehen in der Menüleiste auf Format 
> Zellen, oder Sie wenden die Tastenkombination Strg+1 an, um den Zellen formatieren 
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Dialog zu öffnen (Abbildung 21).

2) Stellen Sie sicher, dass die Zahlen-Seite gewählt ist, wählen Sie anschließend von der Ka-
tegorieliste Text aus.

3) Klicken Sie auf OK. Die Zahl wird in Text umgewandelt und ist standardmäßig nach links 
ausgerichtet. Sie können die Formatierung und Ausrichtung von allen Textzahlen ändern, 
genauso wie Sie es mit normalem Text durchführen würden.

Hinweis
Alle Zahlen, die als Text in einer Tabellenkalkulation formatiert wurden, werden bei 
allen Formeln als eine Null behandelt, die in der Tabellenkalkulation angewendet 
werden. In den Formel-Funktionen werden Texteinträge ignoriert.

Text
Klicken Sie in eine Zelle und tippen Sie den Text ein. Der Text ist standardmäßig nach links aus-

gerichtet. Die Zellen können mehrere Textzeilen enthalten. Wenn Sie Absätze benutzen möchten, 
drücken Sie Strg+Eingabetaste, um einen anderen Absatz zu erstellen.

Auf der Eingabezeile, können Sie die Eingabezeile erweitern, wenn Sie mehrere Textzeilen ein-

geben. Klicken Sie auf das der ausgedehnten Eingabezeile Symbol , die sich auf der rechten 
Seite der Eingabezeile befindet und dadurch wird die Eingabezeile mehrzeilig, wie in Abbildung 22 
gezeigt. Klicken Sie erneut auf das Symbol ausgedehnte Eingabezeile, um wieder zu einer ein-
zeiligen Eingabezeile zurückzukehren.

Datum und Zeit
Markieren Sie die Zelle und geben das Datum oder die Zeit ein. Sie können die Datumselemen-

te mit einem Schrägstrich (/) oder einem Bindestrich (–) trennen oder wenden es als Text an, zum 
Beispiel 10. Oktober 2012. Das Datumsformat ändert automatisch in das ausgewählte Format, das
von Calc angewendet wird.

Wenn Sie eine Zeit eingeben, trennen Sie die zeitlichen Elemente mit einem Doppelpunkten, 
zum Beispiel 10 : 43 : 45. Das Zeitformat ändert automatisch in das ausgewählte Format, das von 
Calc angewendet wird.

Um das Datum oder Zeitformat zu ändern, das von Calc angewendet wird:

1) In der ausgewählten Zelle, klicken Sie mit der rechten Maustaste auf die Zelle, wählen Zel-
len formatieren aus dem Kontext-Menü oder Sie gehen in die Menüleiste auf Format > 

Die Anwendung der Tastatur Seite 10
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Zellen oder wenden die Tastenkombination Strg+1 an, um den Zellen formatieren Dialog 
zu öffnen (Abbildung 21).

2) Stellen Sie sicher, dass die Zahlen-Seite gewählt ist, wählen Sie anschließend Datum oder 
Zeit aus der Kategorieliste.

3) Markieren Sie das Datum oder Zeitformat, das Sie von der Formatliste anwenden wollen.

4) Klicken Sie auf OK, um die Änderungen zu sichern und den Dialog zu schließen.

Sonderzeichen
Ein Sonderzeichen ist ein Zeichen, dass normalerweise auf einer Standardtastatur nicht gefun-

den wird, zum Beispiel, © ¾ æ ç ñ ö ø ¢. Um ein Sonderzeichen einzufügen:

1) Stelle Sie den Cursor in die Zelle, wo Sie das Zeichen zu erscheinen wünschen.

2) Gehen Sie in der Menüleiste auf Einfügen > Sonderzeichen …, um den Sonderzeichen-
dialog zu öffnen (Abbildung 23).

3) Markieren Sie der Reihe nach die Sonderzeichen, die Sie in die Zelle einfügen wollen. Die 
ausgewählten Sonderzeichen werden am unteren Rand, links im Sonderzeichendialog er-
scheinen. Das letzte ausgewählte Zeichen wird im Sonderzeichendialog rechts, zusammen 
mit seinem numerischen Code gezeigt.

4) Klicken Sie auf OK, um den Dialog zu schließen. Die Sonderzeichen sind jetzt in der aus-
gewählten Zelle eingefügt.

Hinweis
Verschiedene Schriftarten enthalten verschiedene Sonderzeichen. Wenn Sie keine 
individuellen Sonderzeichen finden, die Sie möchten, versuchen Sie die Schriftart 
und Teilmenge Auswahl zu ändern.

Die Anwendung der Tastatur Seite 11
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AutoKorrektur Optionen
Calc wendet viele Änderungen während der Dateneingabe mit der AutoKorrektur automatisch 

an, es sei denn, dass Sie irgendeine AutoKorrektur deaktiviert bzw. geändert haben. Sie können 
auch jede AutoKorrektur Änderung mittels der Tastenkombination Strg+Z annullieren oder zu der 
manuellen Änderung zurückgehen und die AutoKorrektur mit etwas ersetzen, das Sie tatsächlich 
sehen möchten.

Um die AutoKorrektur Optionen zu ändern, gehen auf die Menüleiste Sie zu Extras > AutoKor-
rektur-Optionen …, um den AutoKorrektur-Dialog zu öffnen (Abbildung 24).

Die Anwendung der Tastatur Seite 12
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• Ersetzen – Bearbeitet die Ersatztabelle für automatische korrigieren oder zu ersetzen Wör-
ter oder Abkürzungen in Ihrem Dokument.

• Ausnahmen – spezifizieren die Abkürzungen oder Buchstabenkombinationen, die Sie nicht
LibreOffice wünschen, um automatisch zu korrigieren.

• Optionen – wählen Sie die Optionen für automatische Fehler korrigieren, während Sie und 
dann auf OK klicken eingeben.

• Gebietsschemaabhägige Optionen – spezifizieren die AutoKorrektur Optionen für Anfüh-
rungszeichen und für Optionen, die typisch für die Sprache von dem Text sind.

• Zurück – setzt die geänderten Werte auf die standardmäßigen LibreOffice Werte zurück.

Das Einfügen von Gedankenstrichen
Calc bietet Text-Tastenkombinationen an, sodass Sie schnell Gedankenstriche / Bindestriche in 

eine Zelle einfügen können und diese Tastenkombinationen werden in der Tabelle 3 gezeigt.

Die Anwendung der Tastatur Seite 13
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Tabelle 3: Das Einfügen von Gedankenstrichen

Text, den Sie eingeben Ergebnis

A - B (A, Leerzeichen, Bindestrich, Leerzeichen, B) A – B (A, Leerzeichen, en-Gedankenstrich, 
Leerzeichen, B)

A -- B (A, Leerzeichen, Bindestrich, Bindestrich, 
Leerzeichen, B)

A – B (A, Leerzeichen, en-Gedankenstrich, 
Leerzeichen, B)

A – B (A, Bindestrich, Bindestrich, B) A—B (A, em-Gedankenstrich, B)

A-B (A, Bindestrich, B) A-B (unverändert)

A - B (A, Leerzeichen, Bindestrich, B) A - B (unverändert)

A – B (A, Leerzeichen, Bindestrich, Bindestrich, B) A – B (A, Leerzeichen, en-Gedankenstrich, B)

Beschleunigte Dateneingabe

Die Dateneingabe in einem Arbeitsblatt kann sehr arbeitsintensiv sein, aber Calc bietet Werk-
zeuge an, um einiges der Plackerei von Eingaben zu entfernen. Diese Werkzeuge enthalten zie-
hen und ablegen, um Inhalt von einer Zelle zu einer anderen mit einer Maus zu verschieben oder 
zu kopieren, ein AutoEingabe-Werkzeug, das Füll-Werkzeug, und Auswahllisten.

Das Füll-Werkzeug und die Auswahllisten automatisieren die Eingabe von wiederkehrenden Auf-
gaben in Zellen. Calc hat auch die Fähigkeit, Informationen in mehrere Tabellen der gleichen Ta-
bellenkalkulation gleichzeitig einzugeben.

AutoEingabe Werkzeug
Die AutoEingabe Funktion in Calc vervollständigt automatisch die Einträge, basierend auf ande-

re Einträge in der gleichen Spalte. Die Spalte untersucht bis höchstens 2000 Zellen oder 200 ver-
schiedene Zeichenfolgen.

Wenn der Text in einer Zelle hervorgehoben ist, kann die AutoEingabe wie folgt angewendet 
werden:

1) Um die Fertigstellung anzunehmen, drücken Sie die Eingabetaste oder F2 oder die 
Maustaste.

2) Um weitere Vervollständigungen anzuzeigen, wenden Sie die Tastenkombinationen 
Strg+TAB an, um vorwärts zu blättern, oder Strg+Umschalttaste+Tabulator, um rückwärts 
zu blättern.

3) Um eine Liste von allen verfügbaren AutoEingabe-Textelementen für die aktuelle Spalte zu
sehen, verwenden Sie die Tastenkombination Strg+Pfeil nach unten.

Wenn man Formeln mit Zeichen eingibt, um vorherige Einträge anzupassen, wird ein Hilfe-Tipp er-
scheinen und die letzten zehn Funktionen auflisten, die in dem Funktions-Assistenten aus allen de-
finierten Bereichsnamen und aus dem Inhalt von allen Beschriftungsbereichen verwendet werden.

AutoEingabe ignoriert die Groß-/Kleinschrift-Abhängigkeit von allen Daten die Sie eingeben. 

Beschleunigte Dateneingabe Seite 14
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Wenn Sie zum Beispiel in einer Zelle “Gesamt” geschriebene haben, können Sie dann nicht ”ge-

samt” in einer anderen Zelle von derselben Spalte eingeben, ohne zuerst die  AutoEingabe zu 
deaktivieren.

 

Ausfüll-Werkzeug
Sie können das Ausfüll-Werkzeug in Calc anwenden, um den vorhandenen Inhalt zu duplizieren

oder Sie erstellen eine Reihe in einem Zellenbereich in Ihrer Tabellenkalkulation, wie es in den Bei-
spielen in Abbildung 25 gezeigt wird.

1) Markieren Sie die Zelle mit den Inhalten, die Sie zu kopieren wünschen oder starten Sie 
daraus die Reihe.

2) Ziehen Sie den Cursor in irgendeine Richtung oder halten die Umschalt-Taste gedrückt und
klicken in die letzte Zelle, die Sie füllen wollen.

3) Gehen Sie auf die Hauptmenüleiste auf Bearbeiten > Ausfüllen und wählen die Richtung, 
in die Sie zu kopieren wünschen oder erstellen die Daten (Oben, Unten, Links, Rechts, 
Tabelle oder Reihen). Die eine oder andere Menüoption wird ausgegraut sein, wenn diese 
nicht vorhanden ist.

Alternativ können Sie eine Tastenkombination anwenden, um Zellen zu füllen:

1) Markieren Sie die Zelle mit den Inhalten, die Sie kopieren wollen oder starten Sie daraus 
die Reihe.

2) Bewegen Sie den Cursor über den kleinen Auswahlpunkt (■) in der unteren rechten Ecke 

der ausgewählten Zelle. Der Cursor wird die Form ändern (;).

3) Klicken und ziehen Sie in die von Ihnen gewünschte Richtung, sodass die Zellen, vertikal 
oder horizontal, gefüllt werden. Wenn die ursprüngliche Zelle Text enthält, dann wird der 
Text automatisch kopiert werden. Wenn die ursprüngliche Zelle eine Zahl enthält, wird eine 
Reihe erstellt werden.

Beschleunigte Dateneingabe Seite 15
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Hinweis

Wenn Sie Zellen auswählen, damit Sie das Ausfüll-Werkzeug benutzen können, 
vergewissern Sie sich, dass keine der Zellen Daten enthalten, abgesehen von den 
Zellendaten, die Sie benutzen wollen. Wenn Sie das Ausfüll-Werkzeug benutzen, 
werden alle Daten, die in den ausgewählten Zellen enthalten sind, überschrieben.

Die Anwendung, um eine Reihe auszufüllen 

Wenn Sie, um eine Reihe auszufüllen in der Menüleiste von Bearbeiten > Ausfüllen > Reihe 
auswählen, öffnet sich der Reihen füllen Dialog (Abbildung 26). Hier können Sie den Reihentyp 
auswählen, den Sie möchten oder Sie erstellen Ihre eigene Liste.

• Richtung – bestimmt die Richtung die Reihen Erstellung.

− Unten – erstellt eine abwärts gerichtete Reihe in dem ausgewählten Zellenbereich in 
der Spalte mit der definierten Zunahme bis zum Erreichen des Endwerts.

− Rechts – erstellt eine fortlaufende Reihe von links nach rechts innerhalb des ausge-
wählten Zellenbereichs mit der definierten Zunahme bis zum Erreichen des Endwerts.

− Oben – erstellt ein aufwärts gerichtete Reihe in dem Zellenbereich in der Spalte mit der 
definierten Zunahme bis zum Erreichen des Endwerts.

− Links – erstellt eine fortlaufende Reihe von rechts nach links in dem ausgewählten Zel-
lenbereich mit der definierten Zunahme bis zum Erreichen des Endwerts.

• Reihentyp – definiert den Reihentyp.

− Linear – erstellt eine lineare Zahlenreihe mit der definierten Zunahme und Endwert.

− Wachstum – erstellt eine Wachstumsserie mit der definierten Zunahme und Endwert.

− Datum – erstellt eine Datumsreihe mit der definierten Zunahme und Enddatum.

− Auto-Ausfüllen – bildet eine Reihe direkt in der Tabelle. Die Auto-Ausfüllen-Funktion be-
achtet benutzerdefinierte Sortierlisten. Zum Beispiel, bei der Eingabe Januar in der ers-
ten Zelle, wird die Reihe mit der Liste vervollständigt, die in LibreOffice > Extras > Op-
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tionen > LibreOffice Calc > Sortierlisten definiert ist. Das Auto-Ausfüllen versucht 
eine Wertereihe durch die Verwendung eines definierten Musters zu vervollständigen. 
Zum Beispiel, eine Zahlenreihe mit 1,3,5 wird automatisch mit 7,9,11,13 fertiggestellt; 
eine Datum und zeitlichen Reihenfolge mit 01.01.99 und 15.01.99 wird mit einem Inter-
vall von vierzehn Tagen angewandt.

• Zeiteinheit – in diesem Bereich spezifizieren Sie die gewünschte Zeiteinheit. Dieser Be-
reich ist nur aktiv, wenn das Datum in der Option Reihentyp ausgewählt wurde.

− Tag – verwendet im Reihentyp Datum und diese Option, um eine Reihe mit sieben 
Tage zu erstellen.

− Wochentag – verwendet im Reihentyp Datum und diese Option, um eine Reihe von fünf
Tage zu erstellen.

− Monat – verwendet im Reihentyp Datum und diese Option, um eine Reihe aus den Na-
men oder Abkürzungen der Monate zu erstellen.

− Jahr – verwendet im Reihentyp Datum und diese Option, um eine Reihe von Jahren zu 
erstellen.

• Startwert – bestimmt den Startwert für die Reihe. Verwenden Sie Zahlen, Daten oder Zei-
ten.

• Endwert – bestimmt den Endwert für die Reihe. Verwenden Sie Zahlen, Daten oder Zeiten.

• Zunahme – bestimmt den Wert, mit dem die Reihe des ausgewählten Typs sich um jeden 
Schritt erhöht. Einträge können nur erfolgen, wenn die Linear, Wachstum oder Datum Rei-
hentypen ausgewählt wurden.

Beschleunigte Dateneingabe Seite 17
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Das Definieren einer Ausfüllreihe

Um Ihre eigene Ausfüllreihe zu definieren:

1) Gehen Sie auf Extras > Optionen > LibreOffice Calc > Sortierlisten, um den Dialog Sor-
tierlisten zu öffnen (Abbildung 27). Dieser Dialog zeigt alle zuvor definierten Reihen in dem 
linken Feld Listen und die Inhalte der hervorgehobenen Liste in dem Feld Einträge.

2) Klicken Sie auf Neu und das Feld Einträge ist geklärt.

3) Geben Sie für die neue Liste in dem Feld Einträge die gewünschte Reihe ein (einen Ein-
trag pro Zeile) (Abbildung 28).

4) Klicken Sie auf Hinzufügen und die neue Liste wird jetzt in dem Feld Listen erscheinen.

5) Klicken Sie auf OK, um die neue Liste zu speichern und den Dialog zu schließen.
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Auswahllisten
Auswahllisten sind nur für Text verfügbar, und sind nur auf Text begrenzt, der bereits in dersel-

ben Spalte eingegeben wurde.

1) Markieren Sie eine leere Zelle, die in dieser Spalte, Zellen mit Texteinträgen enthält.

2) Machen Sie in dieser Spalte einen Rechtsklick und wählen aus dem Kontext-Menü Aus-
wahllisten. Eine nach unten ausklappbare Befehlsliste erscheint, auflistend alle Zelle in 
derselben Spalte, die entweder mindestens über ein Textzeichen verfügt oder dessen For-
mat als Text definiert ist.

3) Klicken Sie auf den Texteintrag, den Sie benötigen und er ist in die ausgewählte Zelle ein-
gegeben.

Zellen verbinden und teilen

Verbinden
Sie können zusammenhängende Zellen auswählen und diese zu einer, wie folgt verbinden:

1) Markieren Sie einen Bereich aus zusammenhängenden Zellen, die Sie verbinden möchten.

2) Machen Sie einen Rechtsklick auf die ausgewählten Zellen und wählen von dem Kontext-
Menü Zellen verbinden, oder Sie gehen auf Format > Zellen verbinden > Zellen verbin-
den oder in der Menüleiste Zellen verbinden und zentrieren, oder Sie klicken auf das Zel-

len-verbinden und zentrieren Symbol auf der Formatierungs-Symbolleiste. Mit Zellen
verbinden und zentrieren wird jeder Inhalt in den Zellen zentriert ausgerichtet.

3) Wenn die Zellen irgendwelche Daten enthalten, klicken Sie in dem Bestätigungsdialog auf 
Ja, der öffnet, um die Daten der verdeckten Zellen in die erste Zelle zu verschieben.

Zellen verbinden und teilen Seite 19
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Note Durch das Verbinden von Zellen kann es zu Berechnungsfehlern führen, wenn Sie 
Formeln in der Tabellenkalkulation angewendet haben.

Teilen
Sie können eine Zelle nur rückgängig machen oder aufteilen, die aus mehreren Zellen, durch 

verbinden, erstellt wurde.

1) Markieren Sie eine verbundene Zelle.

2) Gehen Sie in der Menüleiste auf Format > Zellen verbinden > Zellen teilen, oder machen
Sie einen Rechtsklick und wählen von dem Kontext-Menü Zellen teilen, oder Sie klicken 

auf der Formatierungs-Symbolleiste auf das Symbol, Zellen verbinden und zentrie-
ren.

3) Alle Daten in der Zelle verbleiben in der ersten Zelle. Wenn die verdeckten Zellen irgendei-
nen Inhalt hatten, bevor die Zellen verbunden wurden, dann müssen Sie den Inhalt in die 
richtige Zelle manuell verschieben.

Der Austausch von Inhalten zwischen den Tabellen

Vielleicht möchten Sie die gleichen Informationen in der gleichen Zelle auf mehrere Tabellen 
ausgeben, zum Beispiel, um standardmäßige Listen für eine Gruppe von Einzelpersonen oder Or-
ganisationen einzurichten. Statt der einzelnen Eingabe der Liste auf jede Tabelle, können Sie die 
Informationen in mehrere Tabellen gleichzeitig eingeben.

1) Gehen Sie in der Menüleiste auf Bearbeiten > Tabelle > Auswählen, um den Dialog Ta-
bellen auswählen zu öffnen (Abbildung 29).

2) Markieren Sie die gewünschte Tabellen, in der die Informationen wiederholt werden sollen. 

3) Klicken Sie auf OK, um die Tabellen und die Tabellen-Tabulatoren auszuwählen, die Farbe 
wird sich dabei verändern.

4) Geben Sie die Informationen in den Zellen auf der Tabelle ein, wo die Informationen zuerst 
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angezeigt werden sollen und die Informationen werden in den ausgewählten Tabellen wie-
derholt.

5) Deaktivieren Sie die Tabellen, wenn Sie die Eingabe der Informationen abgeschlossen ha-
ben, die Sie in den Tabellen zu wiederholen wünschen.

Hinweis

Diese Technik überschreibt automatisch, ohne jede Warnung, alle Informationen, 
die bereits in den Zellen auf den ausgewählten Tabellen sind. Stellen Sie sicher, 
dass Sie die zusätzlichen Tabellen deaktivieren, wenn Sie nach der Eingabe der In-
formationen, für das Wiederholen der Informationen, abgeschlossen haben, bevor 
Sie fortsetzen, Daten in Ihre Tabellenkalkulation einzugeben.

Gültigkeitsprüfung von Zelleninhalten

Beim Erstellen von Tabellenkalkulationen, um diese für andere Personen brauchbar zu machen, 
sollten Sie sicherstellen, dass die Eingabe der Daten für die Zelle gültig oder geeignet sind. Sie 
können auch eine Gültigkeitserklärung in Ihrer eigenen Arbeit, als eine Anleitung zur Dateneingabe
anwenden, das heißt, die entweder umfassend oder nur selten genutzt werden.

Ausfüllreihen und Auswahllisten können einige Datentypen verarbeiten, aber diese sind auf vor-
definierte Informationen begrenzt. Zum Beispiel, eine Zelle kann ein Datum oder eine ganze Zahl, 
ohne alphabetische Zeichen oder Dezimalpunkte, erfordern, oder eine Zelle darf links nicht leer ge-
lassen werden.

Abhängig davon, wie die Gültigkeitserklärung eingerichtet ist, kann es auch den Bereich der In-
halte definieren, die eingegeben werden können, stellt Hilfsmeldungen zur Verfügung, und erklärt 
die erforderlichen Regeln, beim Einrichten der Zelle und was der Anwender ausführen sollte, wenn 
er ungültige Inhalte eingibt. Sie können auch einstellen, dass die Zellen mit ungültigem Inhalt zu 
verweigern bzw. diese mit einer Warnung zu akzeptieren sind oder ein Makro zu starten, wenn ein 
Fehler eingegeben wird.

Das Definieren der Gültigkeit
Um alle neuen Daten zu überprüfen, die in eine Zelle eingegeben werden:

1) Markieren Sie eine Zelle und gehen in der Menüleiste auf Daten > Gültigkeit, um den Gül-
tigkeitsdialog zu öffnen.

Gültigkeitsprüfung von Zelleninhalten Seite 21
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2) Definieren Sie die Art der Inhalte, die in der Zelle mit den bestimmten Optionen, die auf den
Registerkarten für Kriterien, Eingabehilfe und Fehlermeldung versehenen sind, eingege-
ben werden können. Die verfügbaren Optionen sind weiter unten erklärt.

Kriterien Optionen
Spezifizieren Sie für die ausgewählten Zellen die Gültigkeits-Regeln auf der Kriterien Seite in 

dem Gültigkeitsdialog, wie in Abbildung 30 gezeigt. Sie können Kriterien definieren, wie zum Bei-
spiel: Zahlen zwischen 1 und 10 oder Texte, die nicht mehr als 20 Zeichen lang sind.

Die verfügbaren Optionen auf der Kriterien Seite werden davon abhängen, was in der Zulas-
sen-Auswahlliste ausgewählt wurde.

• Zulassen – markieren Sie eine Gültigkeits-Option für ausgewählte Zellen aus der Auswahl-
liste.

− Jeden Wert – keine Begrenzung.

− Ganze Zahl – nur ganze Zahlen sind erlaubt.

− Dezimal – alle Zahlen korrespondieren mit dem Dezimalformat.

− Datum – alle Zahlen korrespondieren mit dem Datumsformat. Die eingegebenen Werte 
werden formatiert, wenn der Dialog das nächste Mal aufgerufen wird.

− Zeit – alle Zahlen korrespondieren mit dem Zeitformat. Die eingegebenen Werte wer-
den formatiert, wenn der Dialog das nächste Mal aufgerufen wird.

− Zellenbereich – erlaubt nur Werte die in einen Zellenbereich eingegeben wurden. Der 
Zellenbereich kann ausdrücklich oder als ein benannter Datenbankbereich, oder als ein
benannter Bereich spezifiziert werden. Der Bereich kann aus einer Spalte oder aus ei-
ner Zellenreihe bestehen. Wenn Sie einen Bereich aus Spalten und Zeilen spezifizie-
ren, wird nur die erste Spalte angewandt.

− Liste – ermöglicht nur Werte oder Zeichenfolgen, die in einer Liste spezifiziert wurden. 
Zeichenfolgen und Werte können gemischt sein. Zahlen werden zu ihrem Wert ausge-
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wertet, wenn Sie also die Zahl 1 in der Liste eingeben, ist auch der Eintrag 100 % gül-
tig.

− Textlänge – Einträge dessen Länge der Anzahl der Zeichen entspricht, die gesetzt wur-
den.

• Leerzellen zulassen – in Verbindung mit Extras > Detektiv > Ungültige Daten einkrei-
sen, wird hiermit dieses definiert, dass die Leerzellen als ungültige Daten gezeigt (deakti-
viert) oder nicht gezeigt (aktiviert) werden.

• Auswahlliste anzeigen – zeigt eine Liste aller gültigen Zeichenfolgen oder Werte an, unter
denen ausgewählt werden kann. Die Auswahlliste kann durch markieren der Zelle und 
Drücken der rechten Maustaste geöffnet werden,

• Einträge aufsteigend sortieren – Sortiert die Auswahlliste in aufsteigender Reihenfolge 
und filtert doppelt vorhandene Einträge in der Liste aus. Wenn die Reihenfolge nicht mar-
kiert ist, wird die Reihenfolge aus der Datenquelle übernommen.

• Quelle – geben Sie den Zellbereich ein, der die gültigen Werte bzw. den Text enthält.

• Einträge – geben Sie die Einträge ein, deren Werte oder Textzeichenfolgen gültig sein wer-
den.

• Daten – markieren Sie den vergleichenden Operator, den Sie aus der Auswahlliste anwen-
den wollen. Die verfügbaren Operatoren hängen davon ab, was Sie in der Zulassen Aus-
wahlliste ausgewählt haben. Wenn Sie beispielsweise Gültiger Bereich auswählen, erset-
zen die Minimum und Maximum Eingabefelder das Feld Wert.

• Wert – geben Sie den Wert für die Gültigkeits-Option der Daten ein, den Sie in der Zulas-
sen-Auswahlliste ausgewählt haben.

• Minimum – geben Sie den Minimalwert für die Gültigkeits-Option der Daten ein, den Sie in 
der Zulassen-Auswahlliste ausgewählt haben.

• Maximum – geben Sie den Maximalwert für die Gültigkeits-Option der Daten ein, den Sie 
in der Zulassen-Auswahlliste ausgewählt haben.

Eingabehilfe Optionen
Geben Sie die Nachricht ein, um angezeigt zu werden, wenn die Zelle oder der Zellenbereich in 

der Tabellenkalkulation ausgewählt ist (Abbildung 31).

• Eingabehilfe anzeigen, wenn die Zelle ausgewählt ist – zeigt die Nachricht, die Sie un-
ter Inhalte in den Titel und Eingabehilfe Feldern eingeben, wenn die Zelle oder Zellenbe-
reich in der Tabelle ausgewählt ist. Wenn Sie in Inhalte Text in den Titel und Eingabehilfe 
Feldern eingeben und dann diese Option wieder abwählen, wird der Text verloren gehen.

• Titel – geben Sie den Titel ein, der angezeigt werden soll, wenn die Zelle oder Zellenbe-
reich ausgewählt ist.

• Eingabehilfe – geben Sie die Nachricht ein, die angezeigt werden soll, wenn die Zelle oder
Zellenbereich ausgewählt ist.
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Fehlermeldung Optionen
Definieren Sie die Fehlermeldung, die angezeigt wird, wenn ungültige Daten in einer Zelle einge-

geben wurden (Abbildung 32).

• Bei Eingabe ungültiger Werte Fehlermeldung anzeigen – wenn dieses ausgewählt ist, 
zeigt die Fehlermeldung in dem eingegebenen Inhalte-Bereich, sobald ungültigen Daten in 
einer Zelle eingegeben wurden.

• Aktion – wählen Sie die Aktion, die auftreten, wenn ungültige Daten in einer Zelle eingege-
ben werden.

− Anhalten – verwirft den ungültigen Eintrag und zeigt einen Dialog, den Sie durch das 
anklicken auf OK, schließen müssen.

− Warnung und Informationen – zeigt einen Dialog, der durch das anklicken auf OK oder 
Abbrechen, geschlossen werden kann. Der ungültige Eintrag ist nur verworfen, wenn 
Sie auf Abbrechen klicken.

− Makro – aktiviert die Schaltfläche Durchsuchen, um den Makro-Dialog zu öffnen, wo 
Sie ein Makro auswählen können, das ausgeführt wird, wenn ungültige Daten in einer 
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Zelle eingegeben wurden. Das Makro wird ausgeführt, nachdem die Fehlermeldung an-
gezeigt wird.

• Titel – geben Sie den Titel des Makros oder der Fehlermeldung ein, die angezeigt werden 
sollen, wenn ungültige Daten in einer Zelle eingegeben werden.

• Fehlermeldung – geben Sie die Nachricht ein, die angezeigt werden sollen, wenn ungülti-
ge Daten in einer Zelle eingegeben werden.

Calc Detektiv
Der Detektiv ist innerhalb von Calc ein Werkzeug, das Sie verwenden können, um irgendwelche 

Zellen in einer Tabellenkalkulation zu ermitteln, die ungültige Daten enthalten, wenn die Zellen so 
eingestellt sind, um ungültige Daten mit einer Warnung aufzuzeigen.

1) Gehen Sie in der Menüleiste auf Extras > Detektiv > Ungültige Daten einkreisen, um alle
Zellen zu ermitteln, die ungültigen Daten enthalten. Die Detektivfunktion markiert alle Zellen
die ungültigen Daten enthalten.

2) Berichtigen Sie die Daten, sodass sie gültig wird.

3) Gehen Sie noch einmal auf die Menüleiste auf Extras > Detektiv > Ungültige Daten ein-
kreisen und alle Zellen die vorher als markiert dargestellt wurden, die ungültigen Daten 
und die ungültige Datenmarke enthalten, zu entfernen.

Hinweis

In der Regel gilt die Gültigkeit als ein Teil der Formatierung für eine Zelle. Wenn Sie 
Alles löschen aus die Inhalte löschen Dialog auswählen (Abbildung 33), dann sind 
diese entfernt. Wenn Sie eine Gültigkeitsregel mit dem Rest von der Zelle kopieren 
wollen, verwenden Sie Bearbeiten > Inhalte einfügen > Formatierungen einfü-
gen oder Alles einfügen.

Das Bearbeiten von Daten

Daten löschen

Nur Daten löschen

Daten können von einer Zelle gelöscht werden, ohne irgendwelche Zellformatierung zu löschen. 
Klicken Sie in die Zelle, um sie auszuwählen und dann drücken Sie die Entf-Taste.

Das Löschen der Daten und der Formatierung

Daten und Zellformatierung können gleichzeitig von einer Zelle gelöscht werden.

1) Klicken Sie in die Zelle, um diese auszuwählen.

2) Drücken Sie die Rücksetztaste, oder machen einen Rechtsklick in die Zelle und wählen aus
dem Kontext-Menü Inhalte löschen aus, oder Sie begeben sich auf die Menüleiste auf Be-
arbeiten > Inhalte löschen, um den Dialog Inhalte löschen zu öffnen (Abbildung 33). Hier
können Sie wählen, um die verschiedenen Aspekte der Daten in der Zelle zu löschen oder 
alles in der Zelle zu löschen.
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3) Markieren Sie die Löschoptionen.

4) Klicken Sie auf OK, um die Inhalte zu löschen und den Dialog zu schließen.

Das Ersetzen der Daten
Um Daten in einer Zelle vollständig zu ersetzen und neue Daten einzufügen, markieren Sie die 

Zelle und geben darin die neuen Daten ein. Die neuen Daten werden die bereits enthaltenen Da-
ten in der Zelle ersetzen und wird die ursprüngliche Formatierung beibehalten, die in der Zelle an-
gewendet wird.

Alternativ klicken Sie in die Eingabezeile auf der Formelleiste, machen dann auf den Daten 
einen Doppelklick, um diese vollständig hervorzuheben und geben jetzt hier die neuen Daten ein.

Das Bearbeiten der Daten
Manchmal ist es notwendig, die Inhalte der Zelle zu bearbeiten, ohne alle Daten von der Zelle zu

entfernen. Zum Beispiel, das Ändern des Ausdrucks “Umsatz in Quartal 2”  in ”Verkauf von Rosen 
im Quartal” können wie folgt durchgeführt werden.

Die Anwendung die Tastatur

1) Klicken Sie in die Zelle, um diese auszuwählen.

2) Drücken Sie die F2-Taste und der Cursor ist am Beginn der Zelle platziert.

3) Drücken Sie die Rücksetztaste, um alle Daten bis zu dem Punkt wo Sie neue Daten einzu-
geben wünschen, zu löschen.

4) Alternativ, gebrauchen Sie die Tastatur-Richtungspfeil-Tasten, um der Cursor neu zu posi-
tionieren, wo Sie beginnen möchten die neuen Daten in der Zelle einzugeben, dann 
drücken Sie die Entf-Taste oder Rücksetztaste, um alle unerwünschten Daten zu löschen, 
bevor Sie die neuen Daten eingeben.

5) Wenn Sie die Bearbeitung abgeschlossen haben, drücken Sie die Eingabetaste, um die 
Änderungen zu speichern.
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Hinweis
Jedes Mal wenn Sie eine Zelle auswählen, werden die Inhalte in der Eingabezeile 
auf der Formelleiste angezeigt. Mit der Eingabezeile kann es leichter sein, um das 
Bearbeiten von Daten auszuführen.

Die Anwendung mit der Maus

1) Machen Sie zur Markierung der Zelle darauf einen Doppelklick, um den Cursor darin zu 
platzieren und um die Zelle zu bearbeiten.

2) Positionieren Sie den Cursor neu und zwar dahin, wo Sie mit der Bearbeitung der Daten in 
der Zelle beginnen möchten.

3) Alternativ, machen Sie hier einen Einzelklick, um die Zelle auszuwählen, dann bewegen Sie
den Cursor zur Eingabezeile auf der Formelleiste und klicken auf die Position, wo Sie viel-
leicht beginnen möchten, die Daten in der Zelle zu bearbeiten.

4) Wenn Sie dieses abgeschlossen haben, klicken Sie abseits von der Zelle, um sie abzuwäh-
len und Ihre Bearbeitungsänderungen werden gespeichert.

Inhalte einfügen Funktion
Sie können die Inhalte einfügen Funktion anwenden, um in einer anderen Zelle, ausgewählte 

Teile der Daten in die ursprüngliche Zelle oder Zellenbereich einzufügen, zum Beispiel sein Format
oder das Ergebnis seiner Formel.

Inhalte einfügen Dialog

1) Markieren Sie eine Zelle oder einen Zellenbereich.

2) Gehen Sie in der Menüleiste auf Bearbeiten > Kopieren, oder Sie machen auf der Zelle 
einen Rechtsklick und wählen aus dem Kontext-Menü Kopieren.

3) Markieren Sie die Zielzelle oder der Zellenbereich.

4) Gehen Sie in der Menüleiste auf Bearbeiten > Inhalte einfügen, oder Sie wenden die Tas-
tenkombination Strg+Umschalttaste+V an, bzw. machen Sie darauf einen Rechtsklick und 
wählen aus dem Kontext-Menü Inhalte einfügen, um den Inhalte einfügen Dialog zu öffnen
(Abbildung 34).

5) Markieren Sie in den Optionen Auswahl, Rechenoperationen, Optionen und Zellen ver-
schieben das entsprechende. Das Einfügen spezieller Optionen ist weiter unten erklärt.

6) Klicken Sie auf OK, um die Daten in die Zielzelle oder dem Zellenbereich einzufügen und 
den Dialog zu schließen.
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Inhalte einfügen Optionen

• Auswahl – wählt ein Format für die Inhalte der Zwischenablage aus, die Sie einfügen 
möchten.

− Alles einfügen – fügt alle Zelleninhalte, Kommentare, Formate und die Objekte in das 
aktuelle Dokument ein.

− Text – fügt in den Zellen enthaltenen Text ein.

− Zahlen – fügt Zellen mit Zahlen ein.

− Datum & Zeit – fügt Zellen mit enthaltenen Datums- und Zeitwerte ein.

− Formeln – fügt Zellen mit enthaltenen Formeln ein.

− Kommentare – fügt Kommentare ein, die an Zellen gebunden sind. Wenn Sie die Kom-
mentare zu dem vorhandenen Zelleninhalt hinzufügen wollen, markieren Sie zusätzlich 
auch die Operation Addieren.

− Formate – fügt die Attribute des Zellenformats ein.

− Objekte – fügt Objekte ein, die in dem ausgewählten Zellenbereich enthalten sind. Die-
ses können OLE-Objekte, Diagramm-Objekte, oder Zeichenobjekte sein.

• Rechenoperationen – Wählen Sie den Vorgang, der beim Einfügen von Zellen in die Ta-
belle ausgeführt werden soll. 

− Keine – Beim Einfügen eines Zellbereichs aus der Zwischenablage wird keine Operati-
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on ausgeführt. Der vorhandene Zellinhalt wird durch den Inhalt der Zwischenablage er-
setzt. 

− Addieren – Die Werte in den Zellen in der Zwischenablage werden zu den Werten in 
den Zielzellen addiert. Liegen in der Zwischenablage nur Kommentare vor, so werden 
diese den Zielzellen hinzugefügt.

− Subtrahieren – Die Werte in den Zellen in der Zwischenablage werden von den Werten 
in den Zielzellen subtrahiert. 

− Multiplizieren – Die Werte in den Zellen in der Zwischenablage werden mit den Werten 
in den Zielzellen multipliziert. 

− Dividieren – Die Werte in den Zellen in der Zwischenablage werden durch die Werte in 
den Zielzellen dividiert.

• Optionen – Legen Sie die Optionen zum Einfügen des Inhalts der Zwischenablage fest. 

− Leerzellen überspringen – Zielzellen werden nicht durch leere Zellen in der Zwischen-
ablage ersetzt. Wenn Sie diese Option in Verbindung mit einer der Operationen Multipli-
zieren oder Dividieren einsetzen, wird diese Operation nicht auf die Zielzellen für leere 
Zellen in der Zwischenablage angewendet.

Wenn Sie eine Rechenoperation auswählen und das Markierfeld Leerzellen übersprin-
gen leer lassen, werden leere Zellen in der Zwischenablage als Nullen behandelt. Bei 
der Operation Multiplizieren wirkt sich dies zum Beispiel so aus, dass die Zielzellen mit
Nullen gefüllt werden.

− Transponieren – Die Zeilen in der Zwischenablage werden als Spalten in den Zielbe-
reich eingefügt. Spalten in der Zwischenablage werden als Zeilen eingefügt.

− Verknüpfen – Der Zellbereich wird als Verknüpfung eingefügt, damit Änderungen an 
den Zellen in der Quelldatei auf die Zieldatei übertragen werden. Um sicherzugehen, 
dass die Änderungen an Leerzellen in der Quelldatei wirklich auf die Zieldatei übertra-
gen werden, vergewissern Sie sich, dass die Option Alles einfügen ebenfalls aktiviert 
ist. 

Es ist auch möglich, Tabellen innerhalb desselben Tabellendokuments miteinander zu 
verknüpfen. Bei der Verknüpfung mit anderen Dateien wird automatisch eine DDE-Ver-
knüpfung erstellt. DDE-Verknüpfungen werden als Matrixformel eingesetzt und können 
nur in ihrer Gesamtheit bearbeitet werden.

• Zellen verschieben – Legt fest, wie die Zielzellen beim Einfügen des Inhalts der Zwischen-
ablage verschoben werden. 

− Nicht verschieben – Die Zielzellen werden durch die eingefügten Zellen ersetzt. 

− Nach unten – Die Zielzellen werden beim Einfügen von Zellen aus der Zwischenablage 
nach unten verschoben. 

− Nach rechts – Die Zielzellen werden beim Einfügen von Zellen aus der Zwischenablage
nach rechts verschoben.
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Nur einfügen Optionen

Wenn Sie nur Text, Zahlen oder Formeln zu Ihrer Zielzelle oder Zellenbereich kopieren wollen:

1) Markieren Sie die Zelle oder den Zellenbereich und kopieren die Daten.

2) Markieren Sie die Zielzelle oder den Zellenbereich.

3) Führen Sie einen Rechtsklick auf der Zielzelle oder dem Zellenbereich aus und wählen Nur
einfügen vom Kontext-Menü, wählen aus diesem anschließend, Text, Zahl oder Formel.

 Feldbefehl Zellen einfügen
Sie können ein Feld, das mit dem Datum, Tabellenname, oder Dokumentname verbunden ist in 

eine Zelle einfügen.

1) Markieren Sie eine Zelle und machen Sie darauf einen Doppelklick, um den Bearbeitungs-
modus zu aktivieren.
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2) Führen Sie einen Rechtsklick aus und wählen Feldbefehl einfügen > Datum oder Tabel-
lenblattname oder Dokumententitel aus dem Kontext-Menü.

Hinweis
Der Feldbefehl einfügen > Dokumententitel fügt den Namen der Tabelle ein und 
nicht den Titel, der auf der Seite Beschreibung im Eigenschaften-Dialog für die 
Datei definiert ist.

Tipp
Die Felder werden aktualisiert, wenn die Tabellenkalkulation, durch die Anwen-
dung der Strg+Umschalttaste+F9 Tastenkombination, gespeichert oder neu be-
rechnet wird.
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Das Formatieren der Daten

Hinweis
Alle in diesem Abschnitt besprochenen Einstellungen können auch als ein Teil der 
Zellenvorlage eingestellt werden. Weitere Informationen finden Sie im Kapitel 4, 
Die Verwendung der Vorlagen und Dokumentvorlagen in Calc.

Die Daten in Calc können auf mehrere Arten formatiert werden. Das Formatieren kann entweder
als Teil einer Zellenvorlage definiert werden, sodass es automatisch angewandt ist, oder es kann 
manuell für die Zelle angewandt werden. Für weitere Kontrollen und zusätzlichen Optionen, mar-
kieren eine Zelle oder Zellenbereich und verwenden den Zellen formatieren Dialog. Alle Format-
optionen werden nachstehend erläutert.

Mehrere Textzeilen
Mehrere Textzeilen können in einer einzelnen Zelle mit automatischem Umbruch oder manuelle 

Zeilenumbrüche eingegeben werden. Jede Methode eignet sich für die unterschiedlichsten Situa-
tionen.

Automatischer Umbruch

Um mehrere Textzeilen in einer Zelle automatisch umzubrechen:

1) Markieren Sie eine Zelle oder Zellenbereich.

2) Klicken Sie mit der rechten Maustaste auf die Auswahl und wählen Sie aus dem Kontext-
Menü Zellen formatieren, oder Sie gehen in der Menüleiste auf Format > Zellen, oder 
drücken Strg+1, um den Zellen formatieren Dialog zu öffnen.

3) Klicken Sie auf das Register Ausrichtung (Abbildung 35).

4) Unter Eigenschaften, wählen Sie Automatischer Zeilenumbruch und klicken anschlie-
ßend auf OK.
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Manuelle Zeilenumbrüche

Um einen manuellen Zeilenumbruch bei der Eingabe in einer Zelle einzufügen, drücken Sie 
Strg+Eingabetaste. Diese Methode arbeitet nicht mit dem Cursor in der Eingabezeile. Bei der Be-
arbeitung des Textes, machen Sie auf die Zelle einen Doppelklick, dann positionieren Sie den Cur-
sor erneut dahin, wo Sie den Zeilenumbruch wünschen.

Wenn ein manueller Zeilenumbruch eingegeben wird, die Zellenbreite ändert sich nicht und Ihr 
Text kann noch das Ende von der Zelle überlappen. Sie müssen die Zellenbreite manuell ändern 
oder Ihren Zeilenumbruch neu positionieren, sodass Ihr Text nicht das Ende der Zelle überlappt.

An Zellgröße anpassen 
Die Schriftgröße der Daten in einer Zelle kann automatisch angepasst werden, sodass diese in 

den Zellrahmen passt.

1) Markieren Sie eine Zelle oder Zellenbereich.

2) Klicken Sie mit der rechten Maustaste auf die Auswahl und wählen aus dem Kontext-Menü,
Zellen formatieren, oder Sie gehen in der Menüleiste auf Format > Zellen, oder drücken 
Strg+1, um den Zellen formatieren Dialog zu öffnen.

3) Klicken Sie auf das Register Ausrichtung (Abbildung 35).

4) Unter Eigenschaften, wählen Sie An Zellgröße anpassen und klicken Sie auf OK.

Das Formatieren von Zahlen
Mehrere unterschiedlich Zahlenformate kann in den Zellen durch die Verwendung von Symbolen

auf der Formatierungs-Symbolleiste angewandt werden (in Abbildung 36 hervorgehoben). Markie-
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ren Sie die Zelle, klicken Sie dann auf das entsprechende Symbol, um das Zahlenformat zu än-
dern.

Für weitere Kontrolle oder um andere Zahlenformate auszuwählen, wenden Sie die Seite Zah-
len auf dem Dialog Zellen formatieren an (Abbildung 21 auf der Seite 9 und “Zahlen“ auf Seite 8):

• Wenden Sie einen die Daten Arten in der Liste Kategorie für die Daten an.

• Kontrollieren Sie die Anzahl der Dezimalstellen und führenden Nullen unter Optionen.

• Geben Sie evtl. einen benutzerdefinierten Format-Code ein.

• Die Einstellung der Sprache kontrolliert die unterschiedlichen Formate der örtlichen Ein-
stellungen, wie zum Beispiel das Datum Format und Währungssymbol.

Das Formatieren der Schriftarten
Um eine Schriftart auszuwählen und um diese für den Einsatz in einer Zelle zu formatieren:

1) Markieren Sie eine Zelle oder Zellenbereich.

2) Klicken Sie rechts auf das kleine Dreieck  des Schriftnamen-Feldes in der Formatie-
rungs-Symbolleiste (in Abbildung 37 hervorgehoben) und wählen Sie eine Schriftart von der
Auswahlliste. Die Schriftart kann auch mit der Schriftartseite auf dem Zellen formatieren 
Dialog geändert werden.

3) Klicken Sie rechts auf das kleine Dreieck  des Schriftgrad-Feldes auf der Formatie-
rungs-Symbolleiste und wählen eine Schriftartgröße von der Auswahlliste. Die Schriftgröße 
kann auch mit der Schriftartseite auf dem Zellen formatieren Dialog geändert werden.

4) Um das Zeichenformat zu ändern, klicken Sie auf die Symbole Fett, Kursiv, oder Unterstri-
chen.

5) Um die Absatzausrichtung der Schriftart zu ändern, klicken Sie auf eine der vier Ausrich-

tungssymbole (Links, Zentriert, Rechts, Blocksatz) .

Note

Um die Sprache anzugeben, die in der Zelle angewendet wird, öffnen Sie die 
Schriftartseite auf dem Dialog Zellen formatieren. Das Ändern der Sprache in einer 
Zelle erlaubt, um innerhalb desselben Dokuments, verschiedene Sprachen zu exis-
tieren. Weitere Informationen über weitere Änderungen zu Schriftmerkmalen, sehen
Sie weiter unten in“Schrifteffekt“.
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Tipp

Um zu wählen, ob die Schriftnamen in ihrer Schriftart oder in unformatierten Text 
anzuzeigen ist, gehen Sie zu Extras > Optionen > LibreOffice > Ansicht und akti-
vieren oder deaktivieren Sie in dem Schriftartlisten Abschnitt die Schriftartenvor-
schau aktivieren Option. Weitere Informationen finden Sie im Kapitel 14 Einrichten 
und Anpassen von Calc.
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Schrifteffekt
1) Markieren Sie eine Zelle oder einen Zellenbereich.

2) Klicken Sie mit der rechten Maustaste auf die Auswahl und wählen aus dem Kontext-Menü 
Zellen formatieren, oder Sie gehen in die Menüleiste auf Format > Zellen, oder Sie 
drücken Strg+1, um den Dialog Zellen formatieren zu öffnen.

3) Klicken Sie im Register auf Schrifteffekt (Abbildung 38).

4) Markieren Sie den Schrifteffekt, den Sie aus den verfügbaren Optionen anwenden wollen. 
Die verfügbaren Optionen sind weiter unten beschrieben.

5) Klicken Sie auf OK, um den Schrifteffekt anzuwenden und den Dialog zu schließen.

Alle Schrifteffekt Änderungen werden in der aktuellen Auswahl angewandt, oder in dem ganzen 
Wort, dass den Cursor enthält, oder in jedem neuen Text den Sie eingeben.

• Schriftfarbe – setzt die Farbe für den ausgewählten Text. Wenn Sie Automatisch auswäh-
len, ist die Textfarbe auf schwarzen mit hellen Hintergründe und auf weiß für dunkle Hinter-
gründe eingestellt. Sie können auch die Schriftart Farbe ändern, durch einen Mausklick auf 

das Dreieck rechts des Schriftartfarbe-Symbols um die Farbpalette anzuzeigen und um
die Schriftfarbe zu ändern, wählen Sie anschließend die gewünschte Farbe.
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• Relief – wendet ein Relief Effekt für den ausgewählten Text an. Das erhabene Relief macht
die erscheinenden Zeichen, als ob sie aus der Seite angehoben sind. Das Relief Vertieft 
macht die erscheinenden Zeichen, als ob sie in die Seite eingedrückt sind.

• Kontur – zeigt die Konturen der ausgewählten Zeichen.

• Schatten – fügt einen Schatten hinzu, der unterhalb und nach rechts des ausgewählten 
Zeichens wirft.

• Überstreichen – wählt den Überstreichen-Stil aus, den Sie anwenden wollen. Um Über-
streichen nur für einzelne Wörter anzuwenden, wählen Sie Wortweise.

• Überstreichen Farbe – wählen Sie die Farbe für die Überstreichung aus.

• Durchstreichen – wählen Sie einen Durchstreichen-Stil für den ausgewählten Text. Wenn 
Sie Ihr Dokument im MS-WORD Format speichern, werden alle Durchstreichen-Stile in ein-
zelne Linien umgewandelt.

• Unterstreichen – wählt den zu unterstreichenden Stil, den Sie anwenden wollen. Um das 
Unterstreichen nur für einzelne Wörter anzuwenden, wählen Sie zuzüglich Wortweise. 
Wenn Sie dem hochgestellten Text Unterstreichen zuweisen, ist das Unterstreichen in dem 
Niveau des Hochgestellten angehoben. Wenn das “Hochgestellt” in einem Wort mit norma-
len Text enthalten ist, wird die Unterstreichung nicht ausgelöst.

• Unterstreichen Farbe – wählen Sie die Farbe für das Unterstreichen aus.

• Wortweise – wendet den ausgewählten Schriftarteffekt nur in Wörtern an und ignoriert 
Leerzeichen.

• Betonungszeichen (’) – wählen Sie das Zeichen, um es unten oder oben über die ganze 
Länge des ausgewählten Textes anzuzeigen.

• Position – gibt an, wo die Betonungszeichen angezeigt werden sollen.

• Vorschaufeld – zeigt eine Vorschau der aktuellen Auswahl.

Text Richtung
Um die Textrichtung innerhalb einer Zelle zu ändern, können Sie das Register Ausrichtung auf 

den Zellen formatieren Dialog (Abbildung 35 auf Seite 35) oder die Symbole auf der Formatie-
rungs-Symbolleiste anwenden.

1) Im Register Ausrichtung des Dialogs Zellen formatieren, markieren Sie die Bezugskante, 
von welcher der Text wie folgt zu drehen ist:

• Textausdehnung von der unteren Zellkante – schreibt den gedrehten Text von unten her
den Zellenrand auswärts.

• Textausdehnung von der oberen Zellkante – schreibt den gedrehten Text vom obersten 
Zellenrand her auswärts.

• Textausdehnung nur innerhalb der Zellen – schreibt den gedrehten Text nur innerhalb 
der Zelle.
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2) Klicken Sie auf das Drehfeld und wählen am Rand des Drehfeldes die Textorientierung und 
dann drehen Sie, bis Sie den erforderlichen Winkel erreichen.

Bei positiven Werten wird der Text nach links, bei negativen Werten nach rechts gedreht.

3) Alternativ, geben Sie die zu drehende Grad Zahl des Textes in das Winkel-Feld ein.

4) Wählen Sie Senkrecht gestapelt, um den Text zu erstellen, der in der Zelle senkrecht er-
scheinen soll. Markieren Sie nur die typographischen Standardeinstellungen den Asiati-
schen Layout-Modus, wenn Sie eine asiatische Sprache in der Zelle anwenden.

Hier legen Sie die typographischen Standardeinstellungen für asiatischen Text fest.

5) Auf diese Befehle kann nur zugegriffen werden, nachdem Sie die Unterstützung für asiati-
sche Sprachen in Extras - Optionen - Spracheinstellungen - Sprachen aktiviert haben.

6) Die Symbole auf der Formatierungs-Symbolleiste können, nachdem die Zelle ausgewählt 
wurde, wie folgt verwendet werden:

• Um die Textrichtung aus horizontal (standardmäßige Richtung) in vertikal zu wechseln, 

klicken Sie auf das “Textrichtung von oben nach unten Symbol“ .

• Um die Textrichtung von vertikal in horizontal (standardmäßige Richtung) zu wechseln, 

klicken Sie auf das “Textrichtung von links nach rechts Symbol“ .

• Um die Textrichtung von links nach rechts, was die standardmäßige Richtung für westli-
che Schriftarten ist, in eine rechts nach links Richtung zu wechseln, die in einigen 
Schriftarten angewendet wird, zum Beispiel arabisch, dann klicken Sie auf das “rechts-

nach-links Symbol“ . Dieses arbeitet nur, wenn eine Schriftart angewendet wurde, 
welches eine rechts nach links Richtung erfordert.

• Um die Textrichtung zurück in die standardmäßige links nach rechts Richtung zu wech-
seln, die in westliche Schriftarten angewendet wird, klicken Sie auf das “links nach 

rechts Symbol“ .

Hinweis

Wenn die Textrichtungssymbole nicht auf der Formatierungs-Symbolleiste verfüg-
bar sind, dann führen Sie einen Rechtsklick in einem leeren Bereich auf den Sym-
bolleisten aus und wählen aus dem Kontext-Menü Sichtbaren Schaltflächen. Kli-
cken Sie auf das Symbol, das Sie fordern und es wird auf der Formatierungs-Sym-
bolleiste platziert werden.

Das Formatieren der Zellenränder
Um die Ränder einer Zelle oder einer Gruppe von ausgewählten Zellen zu formatieren (siehe für

weitere Informationen Fehler: Referenz nicht gefunden).

Die Umrandungs-Symbole auf der Formatierungs-Symbolleiste gelten nur für die Standardstile 
dieser Umrandungen, aber der Dialog Zellen formatieren stellt eine größere Betätigungseinrichtung
darüber bereit, wie die Zellenränder aussehen werden.

Das Formatieren der Daten Seite 40



Kapitel 2   Arbeiten mit Daten

1) Markieren Sie eine Zelle oder einen Zellenbereich.

2) Machen Sie einen Rechtsklick auf die Auswahl und wählen aus dem Kontext-Menü Zellen 
formatieren, oder Sie gehen auf der Menüleiste zu Format > Zellen, oder Sie drücken 
Strg+1, um den Dialog Zellen formatieren zu öffnen.

3) Klicken Sie auf das Register Umrandung (Abbildung 39).

4) Wählen Sie die Optionen auf der Seite Umrandung. Die verfügbaren Optionen sind weiter 
unten gegeben.

5) Klicken Sie auf OK, um den Dialog zu schließen und Ihre Änderungen zu speichern.

6) Alternativ, verwenden Sie die Symbole auf der Format-Symbolleiste, um die standardmäßi-
gen Stile für die Umrandungen anzuwenden.

a) Klicken Sie auf das Umrandungssymbol und wählen eine aus den Umrandungsop-
tionen, die in der Umrandungen Palette angezeigt sind.

b) Klicken Sie auf das “Rahmenstil Symbol“ und wählen eine von den Linienarten 
aus die Rahmenartpalette.

c) Klicken Sie auf das “Linienfarbe Symbol“ und wählen eine Farbe aus der Rahmen-
linien Farbpalette.
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Hinweis

Zellenrand Eigenschaften gelten nur für die ausgewählten Zellen und kann nur ge-
ändert werden, wenn Sie jene Zellen bearbeiten. Wenn zum Beispiel Zelle C3 einen
oberen Rand hat, kann der Rand nur durch die Auswahl von C3 entfernt werden. 
Es kann nicht in C2 entfernt werden, da es der untere Rand für die Zelle C2 zu sein
scheint.

Hinweis

Bei der Eingabe von Rändern mit den Rand-Symbolen auf der Formatierungs-Sym-
bolleiste, haben Sie zwei Möglichkeiten: klicken Sie auf das erforderliche Symbol, 
um einen Rand zu den gegenwärtigen Rändern hinzuzufügen oder Sie halten die 
Umschalttaste+Mausklick, um einen Rand hinzuzufügen und, um die gegenwärti-
gen Ränder zu entfernen.

Die Umrandung-Optionen in sind dem Dialog Zellen formatieren wie folgt verfügbar.

• Linienanordnung – Sie einen der vordefinierten Umrandungsstile aus.

− Standardeinstellungen – wählen Sie für die Anwendung einen der vordefinierten Um-
randungsstile.

− Benutzerdefiniert – klicken Sie in dem Schaubild auf einen Rahmen, um einen der Rän-
der oder kreuzweise Diagonallinien in der Zelle anzuwenden.

• Linie – wählen Sie für die Zellenränder die Linienart.

− Stil  – wählen Sie die Linienart zur Anwendung für den Rand.

− Breite – geben Sie für die Umrandungs-Linien eine anzuwendende Breite an.

− Farbe – wählen Sie für die anzuwendenden Umrandungs-Linien eine Farbe aus.

• Abstand zum Inhalt – geben Sie an, wie viel Freiraum zwischen dem Rand und dem Inhalt
der Auswahl bleiben soll.

− Links – geben Sie den gewünschten Abstand zwischen dem linken Rand und dem In-
halt der Auswahl an.

− Rechts – geben Sie den gewünschten Abstand zwischen dem rechten Rand und dem 
Inhalt der Auswahl an.

− Oben – geben Sie den gewünschten Abstand zwischen dem oberen Rand und dem In-
halt der Auswahl ein.

− Unten – geben Sie den gewünschten Abstand zwischen dem unteren Rand und dem In-
halt der Auswahl ein.

− Synchronisieren – wendet, wenn ein neuer Wert eingegeben wird, denselben ge-
wünschten Abstand zum Inhalt auf alle vier Ränder an.

• Schattenart – wendet einen Schatteneffekt für die Ränder an. Am besten wirkt dieser Ef-
fekt, wenn alle vier Ränder sichtbar sind.

− Position – Wählen Sie eine Schattenart für die ausgewählten Ränder.
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− Distanz – geben Sie die Breite des Schattens ein.

− Farbe – wählen Sie eine Farbe für den Schatten.

Das Formatieren von Zellenhintergründen
Um die Hintergrundfarbe für eine Zelle oder eine Zellengruppe zu formatieren (finden Sie weite-

re Informationen im Fehler: Referenz nicht gefunden):

1) Wählen Sie eine Zelle oder einen Zellenbereich.

2) Klicken Sie mit der rechten Maustaste auf die Auswahl und wählen aus dem Kontext-Menü 
Zellen formatieren aus, oder gehen Sie auf die Menüleiste zu Format > Zellen, oder 
drücken Sie Strg+1 um den Dialog Zellen formatieren zu eröffnen.

3) Klicken Sie auf die Registerkarte „Hintergrund“.

4) Wählen Sie eine Farbe aus der Farbpalette.

5) Klicken Sie auf OK, um Ihre Änderungen zu speichern und den Dialog zu schließen.

6) Alternativ klicken Sie auf die Formatierungs-Symbolleiste auf das Hintergrundfarbe-Sym-

bol und wählen eine Farbe der Hintergrund-Farbpalette aus.

AutoFormat in Zellen und Tabellen

Die Anwendung des AutoFormats
Sie können AutoFormat anwenden, um eine Zellengruppe zu formatieren.

1) Wählen Sie die Zellen in mindestens drei Spalten und Zeilen, inklusive Spalten und Zeilen-
köpfe, die Sie zu formatieren wünschen.

2) Gehe Sie auf die Menüleiste zu Format > AutoFormat, um den Dialog AutoFormat zu öff-
nen (Abbildung 40).

3) Wählen Sie den Formattyp und das Farbenformat aus der Liste 

4) Wenn es erforderlich ist, klicken Sie auf Mehr, um die Formatierung zu öffnen, wenn sie 
nicht sichtbar ist.

5) Wählen Sie in den Eigenschaften Formatierung, um in die Funktion AutoFormat einbezo-
gen zu werden.

6) Klicken Sie auf OK, um die Änderungen zu übernehmen und den Dialog zu schließen.
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Das Definieren eines neuen AutoFormats
Sie können ein neues AutoFormat definieren, sodass es für den Einsatz in allen Tabellenkalkula-

tionen verfügbar wird.

1) Format des Datentyps, Schriftart, Schriftgröße, Zellenränder, Zellen-Hintergrund, und so 
weiter für eine Zellengruppe.

2) Gehen Sie in der Menüleiste zu Bearbeiten > Alles auswählen, um die ganze Tabellenkal-
kulation auszuwählen.

3) Wählen Sie Format > AutoFormat, um den Dialog AutoFormat und die Schaltfläche Hin-
zufügen zu öffnen, die nun aktiv ist.

4) Klicken Sie auf Hinzufügen.

5)  5) in dem Feld Namen des Dialogs AutoFormat Hinzufügen das geöffnet wird, geben 
Sie einen aussagekräftigen Namen für das neue Format ein und klicken auf OK.

6) Klicken Sie nun im Dialog AutoFormat auf OK, um den Dialog zu schließen. Das neue Au-
toFormat ist jetzt in der Formatliste in dem Dialog AutoFormat verfügbar.

Die Anwendung von Themen

Calc umfasst eine Reihe vordefinierter Formatierungsthemen, die Sie auf Tabellendokumente 
anwenden können. Es ist nicht möglich, Themen in Calc hinzuzufügen und um sie dann anschlie-
ßend zu modifizieren. Sie können ihren eigenen Stil ändern, nachdem Sie diesen in einer Tabellen-
kalkulation anwenden, aber dies modifizierten Stile sind nur für den Einsatz in dieser Tabellenkal-
kulation verfügbar, nachdem Sie die Tabellenkalkulation speichern.
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Um ein Thema in einer Tabelle anzuwenden:

1) Klicken Sie in der Formatieren-Symbolleiste auf das Symbol Themenauswahl , um 
den Themenauswahl-Dialog zu öffnen (Abbildung 41). Wenn die Formatieren-Symbolleiste 
nicht sichtbar ist, gehen Sie in der Menüleiste zu Ansicht > Symbolleisten und wählen 
Formatierungen. Der Themenauswahl-Dialog listet die verfügbaren Themen für die ganze 
Tabellenkalkulation auf.

2) Wählen Sie das Thema, das Sie anwenden wollen. Sobald Sie ein Thema wählen, sind die 
Themastile in der Tabelle sichtbar und werden sofort angewandt.

3) Klicken Sie auf OK.

4) Wenn Sie wünschen, können Sie jetzt die Stile und Formatierungs-Fenster öffnen, um spe-
zifische Stile zu modifizieren. Diese Modifikationen verändern nicht das Thema; sie ändern 
nur die Erscheinung des Stils in der spezifischen Tabellenkalkulation, die Sie erstellen. Wei-
teres über Modifizieren von Stilen, finden Sie im Fehler: Referenz nicht gefunden.

Werte hervorheben

Die Funktion Werte hervorheben zeigt Zelleninhalte in verschiedenen Farben, in Abhängigkeit 
von der Art des Inhalts. Ein Beispiel von Werte hervorheben wird in der Abbildung 42 gezeigt.

• Text wird in Schwarz gezeigt.

• Formeln werden in Grün gezeigt.
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Abbildung 41: Themenauswahl-Dia-
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• Zahlen werden in Blau gezeigt.

Die Farben des “Werte hervorheben“ überschreiben alle verwendeten Farben in der Formatie-
rung. Diese Farbänderung gilt nur für die Farben, die auf einer Anzeige zu sehen sind. Wenn eine 
Tabellenkalkulation gedruckt wird, werden die Originalfarben, die für Formatvorlagen verwendet 
werden, gedruckt.

Gehen Sie in der Menüleiste zu Ansicht > Werte hervorheben, oder benutzen Sie das Tasten-
kürzel Strg+F8, um die Funktion EIN oder AUS zu schalten. Wenn das “Werte hervorheben“ abge-
schaltet ist, werden für die Anzeige wieder die ursprünglich formatierten Farben verwendet.

Sie können das “Werte hervorheben“ beim Öffnen einer Tabellenkalkulation in Calc, durch die 
Auswahl in Extras > Optionen > LibreOffice Calc > Ansicht > Werte hervorheben als die Stan-
dardeinstellungen veranlassen. Diese Standardeinstellungen für das “Werte hervorheben“, könnte 
möglicherweise nicht das sein, was Sie möchten, wenn Sie vorhaben, die formatierten Zellen zu 
drucken.

Bedingte Formatierung

Sie können Zellenformate für die Änderung, in Abhängigkeit von Bedingungen einrichten, die Sie
spezifizieren. Bedingte Formatierung wird benutzt, um Daten zu markieren, die außerhalb der Spe-
zifikationen sind, die Sie festgelegt haben. Es wird empfohlen, bedingte Formatierung nicht zu 
überbeanspruchen, da dies den Einfluss von Daten reduzieren könnte, die außerhalb der Spezifi-
kationen fällt, die Sie festgelegt haben.

Sehen Sie Bedingte Formatierung Beispiel auf Seite 50 als Beispiel über die Anwendung von 
bedingter Formatierung.

Hinweis

Bedingte Formatierung hängt von der Anwendung der Stile ab, und die Eigenschaft 
der automatischen Neuberechnung muss aktiviert sein. Wenn Sie mit Stilen nicht
vertraut sind, sehen Sie darüber die weiteren Informationen in dem Fehler: Refe-
renz nicht gefunden.

Einrichten der bedingten Formatierung
1) Aktivieren Sie Neu berechnen in Extra > Zelleninhalte > Neu berechnen.

2) Wählen Sie die Zellen, wo Sie bedingte Formatierung anwenden wollen.
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3) Gehe Sie in der Menüleiste zu Format > Bedingte Formatierung > Bedingung (Abbil-
dung 43), Farbbalken (Abbildung 44) oder Datenbalken (Abbildung 45), um den Dialog 
Bedingte Formatierung zu öffnen. Alle Bedingungen werden bereits definiert angezeigt.

4) Klicken Sie auf Extra, um eine neue Bedingung zu erstellen und zu definieren. Wiederho-
len Sie diesen Schritt nach Bedarf.

5) Wählen Sie eine Vorlage aus der Vorlagen Auswahlliste der bereits definierten Zellvorlagen 
aus. Wiederholen Sie diesen Schritt nach Bedarf.

6) Alternativ, wählen Sie Neue Vorlage, zum Öffnen des Dialogs Zellenformatvorlage (Abbil-
dung 46) und um eine neue Zellenformatvorlage zu erstellen. Wiederholen Sie diesen 
Schritt nach Bedarf.

7) Klicken Sie auf OK, um die Bedingungen zu speichern und den Dialog zu schließen. Die 
ausgewählten Zellen sind jetzt festgelegt, um ein Ergebnis mit Bedingter Formatierung an-
zuwenden.
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Ar-

ten von Bedingter Formatierung

Bedingung

Bedingung ist der Ausgangspunkt, wenn Sie die bedingten Formatvorlagen anwenden. Hier kön-
nen Sie festlegen, welche Formate für die Hervorhebung beliebiger Daten in Ihrer Tabellenkalkula-
tion anzuwenden sind, die nicht in die Spezifikationen fallen, die Sie festgelegt haben.

Farbbalken

Die Verwendung der Farbbalken für das Einstellen der Hintergrundfarbe der Zellen, hängt von 
dem Wert der Daten in einer Tabellenkalkulationszelle ab. Der Farbbalken kann nur angewendet 
werden, wenn Alle Zellen für die Bedingung ausgewählt wurde. Sie können entweder zwei oder 
drei Farben für Ihren Farbbalken anwenden.
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Abbildung 46: Zellenvorlage Dialog
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Datenbalken

Datenbalken liefern eine grafische Darstellung von Daten in Ihrer Tabellenkalkulation. Die 
graphische Darstellung beruht auf den Werten der Daten in einem ausgewählten Bereich. Klicken 
Sie in dem Dialog Bedingte Formatierung auf Mehr Optionen, um festzulegen, wie Ihre Datenbal-
ken aussehen sollen. Datenbalken können nur verwendet werden, wenn für die Bedingung Alle 
Zellen ausgewählt wurde.

Symbolsatz

Symbolsatz zeigt ein Symbol neben Ihren Daten in jeder ausgewählten Zelle an, um eine visuel-
le Darstellung davon zu geben, wo die Zellendaten innerhalb des definierten Bereichs erscheinen, 
die Sie festlegen. Die verfügbaren Symbolsätze sind farbige Pfeile, graue Pfeile, farbige Flaggen, 
farbige Zeichen, Symbole, Bewertungen und Quartale. Der Symbolsatz ist nur zugänglich, wenn 
der Dialog Bedingte Formatierung geöffnet wurde und Alle Zellen für die Bedingung ausgewählt 
wurde.

Bedingte Formatierung Verwaltung
Um in Ihrer Tabellenkalkulation alle bedingten Formatierungen und alle festgelegten Stile zu se-

hen, die verwendet werden:

1) Gehen Sie in der Menüleiste zu Format > Bedingte Formatierung > Verwalten, um den 
Dialog Bedingte Formatierung > Verwalten zu öffnen (Abbildung 47).

2) Wählen Sie einen Bereich aus der Liste Bereich aus und klicken auf Bearbeiten, um die 
Bedingte Formatierung neu zu definieren.

3) Wählen Sie einen Bereich aus der Liste Bereich aus und klicken auf Löschen, um die Be-
dingte Formatierung zu löschen. Die Löschung ist unmittelbar ohne Bestätigung.

4) Wählen Sie Extra, um eine neue Definition von Bedingte Formatierung zu erstellen.

5) Klicken Sie auf OK, um Ihre Änderungen zu speichern und den Dialog zu schließen.

Das Kopieren von Zellenstilen
Um den verwendeten Stil für Bedingte Formatierung später in anderen Zellen anzuwenden:
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1) Klicken Sie auf eine der Zellen, die der Bedingte Formatierung zugewiesen wurde und ko-
pieren Sie die Zelle in die Zwischenablage.

2) Wählen Sie die Zellen, welche dieselbe Formatierung wie die kopierte Zelle empfangen 
werden.

3) Gehe in der Menüleiste zu Bearbeiten > Inhalte einfügen, um den Dialog Inhalte einfügen
zu öffnen (Abbildung 34 auf Seite 30).

4) Überprüfen Sie, dass nur Formate gewählt ist und klicken Sie auf OK, um die Bedingte For-
matierung in die Zelle einzufügen.

Bedingte Formatierung Beispiel
Mit bedingter Formatierung können Sie, zum Beispiel die Summen hervorheben, die den Durch-

schnittswert von allen Summen übersteigen. Wenn sich die Summen ändern, ändert sich die For-
matierung dementsprechend, ohne dass man andere Stile manuell anwenden muss. Es wird emp-
fohlen, dass der Stile- und Formatierungs-Dialog geöffnet und sichtbar ist, bevor Sie fortsetzen.

Das Definieren von Bedingungen

1) Wählen Sie die Zellen, in denen Sie einen bedingten Stil anwenden wollen.

2) Gehen Sie auf der Menüleiste zu Format > Bedingte Formatierung > Bedingung bzw. 
Farbbalken oder Datenbalken, um den Dialog Bedingte Formatierung zu öffnen.

3) Geben Sie die Bedingungen ein, die Sie für die Bedingte Formatierung anwenden möchten.

Das Erzeugen von Zahlenwerten

Vielleicht wollen Sie in Ihren Tabellen bestimmten Werten eine besondere Betonung geben. Zum
Beispiel, in einer Tabelle aus Umsätzen, können Sie alle Werte über den Durchschnitt in Grün und 
alle jene unter dem Durchschnitt in Rot anzeigen. Dies ist mit der Bedingten Formatierung mög-
lich.

1) Erstellen Sie eine Tabelle, in der ein paar unterschiedliche Werte auftreten. Für Ihren Test 
können Sie Tabellen mit irgendwelchen Zufallszahlen erstellen. In eine der Zellen geben 

Sie die Formel =ZUFALLSZAHL(), ein und Sie werden eine Zufallszahl zwischen 0 und 1 

erhalten. Wenn Sie Ganzzahlen zwischen 0 und 50 wollen, geben Sie die Formel =GANZ-

ZAHL(ZUFALLSZAHL()*50) ein.

2) Kopieren Sie die Formel, um eine Reihe von Zufallszahlen zu erstellen.

3) Klicken Sie auf die untere rechte Ecke der ausgewählten Zelle, und ziehen Sie nach rechts 
und abwärts, bis der gewünschte Zellenbereich ausgewählt ist.

Das Festlegen der Zellenvorlagen

Der nächste Schritt ist eine Zellenvorlage für alle Werte anzuwenden, welche den überdurch-
schnittlichen Umsatz repräsentieren und eine für die Zellen, die unter dem Durchschnitt sind.

1) Klicken Sie in eine leere Zelle, rufen Sie dort das Kontextmenü auf, und wählen Sie Zelle 
formatieren.
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2) Im Dialog Zellen formatieren wählen Sie im Register Hintergrund die gewünschte Hinter-
grundfarbe. Klicken Sie auf OK.

3) Klicken Sie in den Zellvorlagen auf das Symbol Neue Vorlage aus Auswahl. Geben 
Sie einen Namen für die neue Formatvorlage ein. Nennen Sie die Formatvorlage in diesem 
Beispiel “Oben“.

4) Um eine weitere Formatvorlage zu definieren, klicken Sie erneut in eine leere Zelle und ge-
hen wie oben beschrieben vor. Weisen Sie der Zelle eine andere Hintergrundfarbe zu, 
und benennen Sie die Formatvorlage hier “Unten“.

Mittelwert berechnen

In unserem besonderen Beispiel, werden wir den Mittelwert der Zufallswerte berechnen. Das Er-
gebnis wird in einer Zelle ausgegeben:

1) Klicken Sie in eine leere Zelle, z. B. J14, und gehen Sie in der Menüleiste zu Einfügen > 

Funktion, oder Sie klicken in der Formelleiste auf das Funktionsassistenten-Symbol , 
um den Funktionsassistenten-Dialog zu öffnen.

2) Wählen Sie die Funktion MITTELWERT. 

3) Wählen Sie per Maus alle Ihre Zufallszahlen aus. Wenn Sie den Bereich nicht ganz sehen, 
weil er vom Funktions-Assistenten verdeckt wird, können Sie den Dialog mit der Taste Ver-

größern/Verkleinern vorübergehend verkleinern.

4) Schließen Sie den Funktionsassistenten mit OK.

Zellformatvorlagen anwenden

Nun müssen Sie nur noch die bedingte Formatierung auf Ihre Tabelle anwenden:

1) Wählen Sie alle Zellen mit den Zufallszahlen aus.

2) Gehen Sie in der Menüleiste zu Format > Bedingte Formatierung, um den Dialog Be-
dingte Formatierung zu öffnen.

3) Legen Sie die Bedingung für jede Zelle wie folgt fest: wenn der Zellenwert kleiner als J14 
ist, formatieren Sie die Zellenvorlage mit Unterhalb oder, wenn der Zellenwert größer als 
oder gleich J14 ist, formatieren Sie die Zellenvorlage mit Oberhalb.

Das Verbergen und das Anzeigen der Daten

In Calc können Sie Elemente verbergen, sodass sie weder auf einem Computer-Bildschirm 
sichtbar sind noch gedruckt wird, wenn eine Tabellenkalkulation gedruckt werden soll. Allerdings 
können versteckte Elemente noch immer zum Kopieren ausgewählt werden, wenn Sie die Elemen-
te um sie herum auswählen; zum Beispiel, wenn die Spalte B ausgeblendet ist, wird sie kopiert, 
wenn Sie die Spalten A und C auswählen. Wenn Sie ein ausgeblendetes Element wieder benöti-
gen, können Sie den Prozess umkehren und das Element wieder anzeigen.
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Das Ausblenden der Daten

Tabellen, Zeilen und Spalten

1) Wählen Sie die Tabelle, Zeile oder Spalte, die Sie ausblenden wollen.

2) Gehen Sie auf der Menüleiste zu Format und wählen Tabelle, Zeile oder Spalte.

3) Wählen Sie in dem Menü Ausblenden und die Tabelle, Zeile oder Spalte können nicht 
mehr betrachtet oder gedruckt werden. Alternativ klicken Sie mit der rechten Maustaste auf 
den Tabellentabulator, Zeilenkopf, oder Spaltenkopf und wählen von dem Kontext-Menü 
Ausblenden.

Zellen

1) Gehen Sie in der Menüleiste zu Extra > Dokument schützen > Tabelle, um den Dialog 
Tabelle schützen zu öffnen (Abbildung 48).

2) Wählen Sie diese Tabelle und die Inhalte gesperrter Zellen schützen aus. 

3) Erstellen Sie ein Kennwort und bestätigen Sie dann das Kennwort.

4) Aktivieren oder deaktivieren Sie die Optionen für Alle Nutzer dieser Tabelle dürfen: so 
können Anwender geschützte oder ungeschützte Zellen auswählen.

5) Klicken Sie auf OK, um die Änderungen zu sichern und den Dialog zu schließen.

6) Wählen Sie die Zellen, die Sie ausblenden wollen.

7) Gehen Sie in der Menüleiste zu Format > Zellen, oder Sie machen einen Rechtsklick und 
wählen aus dem Kontext-Menü Zellen formatieren, oder Sie wenden das Tastenkürzel 
Strg+1 an, um den Dialog Zellen formatieren zu öffnen (Abbildung 49).

8) Klicken Sie auf das Register Zellschutz und wählen Sie eine Option für das Ausblenden 
und Drucken der Zellen.

9) Klicken Sie auf OK, um die Änderungen zu sichern und den Dialog zu schließen.
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Hinweis
Wenn Daten in Zellen verborgen sind, sind es nur die Daten, die in den Zellen ent-
halten sind, die verborgenen und die geschützten Zellen können nicht modifiziert 
werden. Die leeren Zellen bleiben in der Tabellenkalkulation sichtbar.

Das Anzeigen von Daten

Tabellen, Zeilen und Spalten

1) Markieren Sie die Tabellen, Zeilen oder Spalten auf jeder Seite der ausgeblendeten Tabel-
le, Zeile oder Spalte.

2) Gehen Sie in der Menüleiste zu Format und wählen Tabelle, Zeile oder Spalte.

3) Wählen Sie aus dem Kontext-Menü Anzeigen und die Tabelle, Zeile oder Spalte werden 
angezeigt und können gedruckt werden.

4) Alternativ, Sie machen auf den Tabellentabulatoren, Zeilenköpfen oder Spalten-Überschrif-
ten einen Rechtsklick und wählen aus dem Kontext-Menü Anzeigen.

Zellen

1) Gehen Sie in der Menüleiste zu Extra > Dokument schützen > Tabelle, um den Dialog 
Tabelle schützen zu öffnen (Abbildung 48).

2) Geben Sie das Kennwort ein, um den Schutz der Tabelle aufzuheben und klicken anschlie-
ßend auf OK.

3) Gehen Sie in der Menüleiste auf Format > Zellen, oder Sie machen darauf einen 
Rechtsklick und wählen aus dem Kontext-Menü Zellen formatieren, oder Sie wenden die 
Tastenkombination Strg+1 an, um den Dialog Zellen formatieren zu öffnen (Abbildung 49).

4) Klicken Sie auf den Tabulator Zellschutz und deaktivieren für die Zellen die Optionen Alles
ausblenden.

5) Klicken Sie anschließend auf OK.
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Gruppierung und Gliederung
Wenn Sie ständig das Verbergen und das Anzeigen der gleichen Zellen durchführen müssen, 

können Sie einer Gliederung von Ihren Daten erstellen und Zeilen oder Spalten zusammen grup-
pieren, sodass Sie in einer Gruppe zusammenfallen können, um sie zu verbergen oder als eine 
Gruppe auszubreiten, um sie mit einem einzigen Klick anzuzeigen.

Die grundlegenden Steuerfunktionen für Gruppierung und Gliederung weisen ein Plus (+) oder 
Minus (-) Zeichen auf der Gruppenanzeige auf, um Zeilen oder Spalten anzuzeigen oder zu ver-
bergen. Wenn jedoch Gruppen innerhalb ineinander verschachtelt sind, haben die grundlegenden 
Steuerfunktionen nummerierte Schaltflächen, so können Sie die verschiedenen Stufen aus ver-
schachtelten Gruppen ein- bzw. ausblenden.

Gruppierung

Um Zeilen oder Spalten zu gruppieren:

1) Wählen Sie die benötigten Zellen, um diese in Ihrer Tabellenkalkulation zu gruppieren.

2) Gehen Sie in der Menüleiste zu Daten > Gruppierung und Gliederung > Gruppierung, 
oder Sie drücken die F12-Taste.

3) In dem Gruppierungs-Dialog, der sich öffnet, wählen Sie entweder Zeilen oder Spalten und 
klicken anschließend auf OK. Eine Gruppenanzeige erscheint links von allen gruppierten 
Zeilen oder oberhalb allen gruppierten Spalten. Die Abbildung 50 zeigt eine Gruppenanzei-
ge links von den ersten zwei Zeilen der Tabellenkalkulation, die gruppiert wurden.

Das Verbergen von Details

Um die Details aus einer beliebigen Gruppe aus Zeilen oder Spalten zu verbergen:

1) Klicken Sie in der Gruppenanzeige auf das Minus (-) Zeichen (rot gekennzeichnet).

2) Alternativ, Sie wählen innerhalb der Gruppe eine Zelle und begeben sich auf die Menüleiste
zu Daten > Gruppierung und Gliederung > Details ausblenden.

3) Die Zeilen oder Spalten werden ausgeblendet und das Minus (-) Zeichen auf der Gruppen-
anzeige wird ein Plus (+) Zeichen.
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Das Anzeigen von Details

Um die Details von beliebigen ausgeblendeten Gruppen oder Zeilen oder Spalten anzuzeigen:

1) Klicken Sie in der Gruppenanzeige auf das Plus (+) Zeichen.

2) Alternativ, Sie wählen eine Zelle auf jeder Seite der ausgeblendeten Gruppe und gehen in 
der Menüleiste auf Daten > Gruppierung und Gliederung > Details anzeigen.

3) Die ausgeblendeten Zeilen oder Spalten werden angezeigt und das Plus (+) Zeichen in der 
Gruppenanzeige wird ein Minus (-) Zeichen.

Aufheben der Gruppierung

Um die Gruppen von Zeilen oder Spalten aufzuheben:

1) Stellen Sie sicher, dass die gruppierten Zeilen oder Spalten angezeigt sind.

2) Gehen Sie in der Menüleiste zu Daten > Gruppierung und Gliederung > Gruppierung 
aufheben, oder wenden die Tastenkombination Strg+F12 an.

3) Wählen Sie entweder Zeilen oder Spalten in der Gruppierung aufheben und klicken an-
schließend auf OK.

Hinweis
Alle ausgeblendeten Gruppen von Zeilen oder Spalten müssen angezeigt sein. 
Wenn sie ausgeblendet sind, dann sind die gruppierten Zeilen oder Spalten in Ihrer 
Tabellenkalkulation gelöscht.

Hinweis Wenn es verschachtelte Gruppen gibt, ist nur die letzte Gruppe von den erstellten 
Zeilen oder Spalten aufgehoben.

AutoGliederung

Wenn ein ausgewählter Zellenbereich Formeln oder Referenzen enthält, umrandet Calc die Aus-
wahl automatisch. Zum Beispiel, in der Abbildung 51 enthalten die Zellen für das 1. und 2te Quar-
tal, je ein Summen-Schema, jeweils für diese linken drei Zellen. Wenn Sie den Befehl AutoGliede-
rung anwenden, werden die Spalten in zwei Quartale gruppiert.

Um die AutoGliederung Funktion anzuwenden, gehen Sie in der Menüleiste zu Daten > Grup-
pierung und Gliederung > AutoGliederung. Calc wird dann die Zellen, die Formeln oder Refe-
renzen enthalten, überprüfen und gruppiert die Zellen automatisch, falls erforderlich.
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Das Entfernen

Um beliebige Zellengruppen von den Zeilen oder Spalten zu entfernen, gehen Sie in der Menü-
leiste zu Daten > Gruppierung und Gliederung > Entfernen und die beliebigen Gruppen werden 
entfernt.

Auch jede Zellengruppe mit ausgeblendeten Zeilen oder Spalten, ist diese Gruppierung der Zel-
len ebenso dadurch entfernt und die Zellen werden in Ihrer Tabellenkalkulation angezeigt.

Die Filterung

Ein Filter ist eine Liste von Bedingungen, die jedem Eintrag entsprechen muss, um angezeigt zu
werden. Calc stellt drei Filterarten zur Verfügung:

• Standard – spezifiziert die logischen Bedingungen, um Ihre Daten zu filtern.

• AutoFilter – filtert Daten laut einem spezifischen Wert oder einer Zeichenkette. Dieses fil-
tert den ausgewählten Zellenbereich automatisch und erstellt einzeilige Listenfelder, wo Sie
die einzelnen Elemente auswählen können, die Sie anzeigen lassen wollen.

• Erweitert –  verwendet Filterkriterien aus angegebenen Zellen.

Die Anwendung eines Standardfilters

Ein Standardfilter ist umfangreicher als ein AutoFilter. Sie können bis zu acht Bedingungen als 
Filter festlegen, kombiniert mit der Operatoren UND bzw. ODER. Standardfilter eignen sich haupt-
sächlich für Zahlen, obwohl einige der bedingten Operatoren ebenso auch für Text genutzt werden 
können.

1) Wählen Sie in Ihrer Tabellenkalkulation einen Zellenbereich.

2) Gehen Sie in der Menüleiste zu Daten > Filter > Standardfilter, um den Standardfilterdia-
log zu öffnen (Abbildung 52).

3) Wählen Sie die Filterkriterien und Filterung-Optionen aus, die Sie anwenden wollen.

4) Klicken Sie auf OK, um die  Standardfilterung auszuführen und den Dialog zu schließen. 
Alle Aufzeichnungen, die die Filterkriterien und Optionen vergleichen, die Sie angegeben 
haben, werden gezeigt.
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Die Filterkriterien, die in Standardfilterung verwendet werden, definiert einen Filter durch das An-
zeigen der Linienart, des Feldnamens, einer logischen Bedingung und eines Werts oder einer 
Kombination aus Argumenten.

• Operator – für die folgenden Argumente, können Sie zwischen den logischen Operatoren 
UND bzw. ODER wählen.

• Feldname – bestimmt die Feldnamen aus der aktuellen Tabelle, um sie in das Argument zu
setzen. Sie werden die Spaltenidentifizierungszeichen sehen, wenn kein Text für die Feld-
namen zur Verfügung steht. Sollten keine Feldnamen in Textform vorliegen, werden hier die
Spaltenbeschriftungen angezeigt.

• Bedingung – gibt die Vergleichsoperatoren an, durch welche die Einträge in den Feldern 
Feldname und Wert verknüpft werden können.

• Wert – bestimmt einen Wert, um das Feld zu filtern. Das Werte-Listenfeld enthält alle mög-
lichen Werte für den spezifizierten Feldnamen. Wählen Sie einen Wert, um ihn in dem Fil-
ter anzuwenden, einschließlich – Leer - oder - Nicht leer - Einträge.

• Groß- und Kleinbuchstaben – unterscheidet beim Filtern der Daten zwischen Groß- und 
Kleinbuchstaben.

• Bereich enthält Spaltenbeschriftungen – enthält die Spaltenbeschriftungen in der ersten 
Zeile eines Zellenbereichs.

• Kopiere Ergebnisse nach – wählen Sie das Kontrollkästchen und wählen Sie dann den 
Zellbereich aus, in dem die Filterergebnisse angezeigt werden sollen. Sie können auch in 
der Liste einen benannten Bereich auswählen.
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• Regulärer Ausdruck - gestattet Ihnen in der Filterdefinition die Verwendung von Platzhal-
tern. Eine Liste der von LibreOffice unterstützten regulären Ausdrücke finden Sie hier. 
Wenn das Kontrollkästchen Regulärer Ausdruck aktiviert ist, können Sie auch reguläre 
Ausdrücke in dem Feld “Wert“ verwenden, wenn das Listenfeld “Bedingung“ auf ’=’ GLEICH
oder ’<>’ UNGLEICH gesetzt ist. Dies gilt auch für die jeweiligen Zellen, auf die Sie für 
einen erweiterten Filter verweisen.

• Keine Duplikate - schließt doppelte Zeilen in der Liste der gefilterten Daten aus.

• Filterkriterien beibehalten – wählen Sie Kopiere Ergebnisse nach und  geben dann den 
spezifizierten Zielbereich an, wo Sie die gefilterten Daten anzuzeigen wünschen. Wenn die-
ses Kästchen aktiviert ist, bleibt der Zielbereich mit dem Quellenbereich verknüpft. Sie 
müssen den Quellenbereich unter Daten > Bereich festlegen, und als einen Datenbank-
bereich definiert haben. Danach können Sie den definierten Filter jederzeit wie folgt erneut 
anwenden: klicken Sie in den Quellbereich und wählen Sie dann Daten - Bereich aktuali-
sieren.

Die Anwendung eines AutoFilters

Ein AutoFilter fügt eine Auswahlliste in die oberste Zeile von einer oder mehreren Datenspalten 
hinzu, die Sie die Zeilen zum Anzeigen auswählen lässt. Die Liste enthält in den ausgewählten Zel-
len jeden einzelnen Eintrag, einsortiert in lexikalischer Reihenfolge (für eine Erklärung der lexikali-
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schen Reihenfolge siehe http://sheepsystems.com/bookdog/HelpBook/LexicalOrder.html).

AutoFilter kann auf mehreren Tabellen angewendet werden, ohne zuerst einen Datenbereich zu 
bestimmen.

1) Klicken Sie in Ihrer Tabellenkalkulation auf einen Zellenbereich. Wenn Sie mehrere AutoFil-
ter in der gleichen Tabelle anwenden wollen, müssen Sie zuerst einen Datenbereich mar-
kieren, dann wenden Sie die AutoFilter in den Datenbereichen an.

2) Gehen Sie in der Menüleiste zu Daten > Filter > AutoFilter. Eine Pfeil-Schaltfläche ist un-
terhalb eines jeden Spaltenkopfs eines Datenbereichs hinzugefügt.

3) Klicken Sie in der Spalte auf den Pfeil oder dem kleinen Dreieck, die den Wert oder die Zei-
chenfolge enthält, die Sie als die Filterkriterien einstellen wollen (in Abbildung 53 gezeigt).

4) Wählen Sie den Wert oder die Zeichenfolge, die Sie als die Filterkriterien anwenden wollen.
Die Aufzeichnungen, welche mit den Filterkriterien übereinstimmen, die Sie ausgewählt ha-
ben, werden dann gezeigt.

Die Anwendung eines Spezialfilters

Ein Spezialfilter hat eine Struktur ähnlich einem Standardfilter. Der Unterschied ist, dass die 
Spezialfilterargumente nicht in einem Dialog eingegeben werden. Stattdessen können Filter in 
einen leeren Bereich einer Tabellenkalkulation eingegeben werden, durch das dann in dem Filter-
dialog die Verweise angebracht sind, um die Filter anzuwenden.

1) Wählen Sie in Ihrer Tabellenkalkulation einen Zellenbereich.

2) Gehen Sie in der Menüleiste zu Daten > Filter > Spezialfilter, um den Spezialfilterdialog 
zu öffnen (Abbildung 54).

3) In Filterkriterien befinden sich in, wählen Sie den benannten Bereich, oder geben Sie 
den Zellenbereich ein, welcher die gewünschten Filterkriterien enthält, die Sie anwenden 
wollen. 

4) Klicken Sie auf OK, um den Spezialfilter auszuführen und den Dialog zu schließen. Alle 
Aufzeichnungen, die mit den Filterkriterien und Optionen übereinstimmen, werden Ihnen 
damit spezifiziert angezeigt.
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Hinweis
Die Optionen für den Spezialfilter sind dieselben, wie diejenigen, die für die 
Standardfilterung verwendet sind, sehen Die Anwendung eines Standardfilters 
auf Seite 59 für weitere Informationen.

Das Sortieren von Aufzeichnungen

Das Sortieren innerhalb von Calc ordnet die Zellen in einer Tabelle mit den Sortierkriterien an, 
die Sie festlegen. Weitere Kriterien können verwendet werden und ein Sortieren wendet jede Krite-
ria nacheinander an. Die Sortierungen sind nützlich, wenn Sie nach einem besonderen Eintrag su-
chen und werden dadurch für Sie sogar noch nützlicher, nachdem Sie gefilterte Daten haben.

Außerdem, Sortierungen sind nützlich, wenn Sie neue Informationen in eine Tabellenkalkulation 
hinzufügen. Wenn eine Tabellenkalkulation sehr groß und ausgedehnt ist, ist es gewöhnlich leich-
ter, neue Informationen am unteren Ende der Tabelle hinzuzufügen, anstatt das Hinzufügen von 
Zeilen an ihren vorgeschriebenen Platz. Nachdem sie die Informationen hinzugefügt haben, kön-
nen Sie dann die Aufzeichnungen sortieren, um die Tabellenkalkulation zu aktualisieren.

Sortieren Dialog
Um Zellen in einer Tabellenkalkulation mit dem Sortieren Dialog zu sortieren (Abbildung 55):

1) Wählen Sie die zu sortierenden Zellen aus.

2) Gehen Sie in der Menüleiste zu Daten > Sortieren, um den Sortieren-Dialog zu öffnen. 
Überprüfen Sie, ob die Sortierkriterien Seite geöffnet ist.

3) Wählen Sie aus den Auswahllisten die Sortierkriterien. Die ausgewählten Listen sind mit 
den ausgewählten Zellen bestückt.

4) Wählen Sie entweder die aufsteigende Reihenfolge (A-Z, 1–9) oder absteigende Reihenfol-
ge (Z-A, 9–1) aus.
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5) Klicken Sie auf OK und das Sortieren wird auf Ihrer Tabellenkalkulation ausgeführt.

Sortieroptionen
Auf der Optionenseite des Sortieren-Dialogs (Abbildung 56), können Sie zusätzliche Optionen 

einstellen:

• Groß-/Kleinschrift berücksichtigen – sortiert zuerst nach Großbuchstaben und dann 
nach Kleinbuchstaben. Für asiatische Sprachen, werden besondere Handhabungen an-
wendet.
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Hinweis

Für asiatische Sprachen, wählen Sie Groß-/Kleinschreibung, um den mehrstufi-
gen Vergleich anzuwenden. Mit dem mehrstufigen Vergleich, werden erste Einträge
in ihren primitiven Formen mit ihren Fällen und diakritischen ignorierten Zeichen 
verglichen. Wenn sie nochmals dasselbe auswerten, werden ihre diakritischen Zei-
chen für den zweiten Stufenvergleich in Betracht gezogen. Wenn sie weiterhin 
ebenso dasselbe auswerten, werden ihre Fälle, Zeichenbreiten, und japanische 
Kana Unterschied für den dritten-Stufen Vergleich berücksichtigt.

• Bereich enthält Spaltenbeschriftungen – lässt die erste Zeile oder die erste Spalte in der
Auswahl des Sortierens aus. Die Richtung stellen Sie im unteren Teil des Dialogs ein, das 
den Namen und die Funktion in diesem Markierungskästchen definiert.

• Formate einschließen – bewahrt die aktuelle Zell-Formatierung.

• Natürliche Sortierung aktivieren – Natürliche Sortierung ist ein Sortieralgorithmus, der 
mit einer Zeichenfolge vorangestellte Zahlen sortiert, die auf den Wert des Zahlenelements 
in jeder sortierten Zahl basiert, anstatt auf der traditionellen Art sie als gewöhnliche Zei-
chenfolgen zu sortieren. Lassen Sie uns zum Beispiel annehmen, Sie haben eine Werterei-
he wie A1, A2, A3, A4, A5, A6, …, A19, A20, A21. Wenn Sie diese Werte in einen Zellenbe-
reich bringen und sie sortieren lassen, wird A1, A11, A12, A13, …, A19, A2, A20, A21, A3, 
A4, A5, …, A9 herauskommen. Während diese Sortieren-Handlungsweise Sinn für diejeni-
gen machen kann, die den zu Grunde liegenden Sortier-Mechanismus verstehen, erscheint
es bis auf den Rest der Bevölkerung vollständig verwirrend, wenn nicht gar vollständig un-
praktisch. Mit der aktivierten Funktion Natürliche Sortierung, werden Werte, wie zum Bei-
spiel diejenigen in dem obigen Beispiel korrekt sortiert, welche die Annehmlichkeit die Sor-
tieren-Ausführungen im Allgemeinen verbessert.

• Sortierergebnisse ausgeben nach – kopiert die sortierte Liste in den Zellenbereich, den 
Sie festgelegt haben. Wählen Sie einen benannten Zellenbereich, wo Sie die sortierte Liste 
anzuzeigen wünschen, oder geben Sie einen Zellenbereich in das Eingabefeld ein.

• Benutzerdefinierte Sortierreihenfolge – wählen Sie diese Option und wählen Sie dann 
die benutzerdefinierte Sortierreihenfolge, die Sie anwenden wollen. Um eine benutzerdefi-
nierte Sortierreihenfolge zu definieren, gehen Sie zu Extras > Optionen > LibreOffice 
Calc > Sortierlisten.

• Sprache – wählen Sie die Sprache für die Sortierkriterien.

• Optionen – wählen Sie eine Sortieroption für die Sprache aus. Zum Beispiel, wählen Sie 
die “Telefonbuch“ Option für Deutsch, um die Umlaute in die Sortierung einzubeziehen.

• Oben nach unten (Zeilen sortieren) – sortiert Zeilen nach den Werten in den aktiven 
Spalten des ausgewählten Bereichs.

• Links nach rechts (Spalten sortieren) – sortiert Spalten nach den Werten in den aktiven 
Zeilen des ausgewählten Bereichs.

Schnellsortierung
Wenn die Spalten in Ihrer Tabellenkalkulation einen Titelkopf mit einem Textformat haben, kön-
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nen Sie eine Schnellsortierung benutzen.

1) Wählen Sie eine Zelle oder ein Zellenbereich zum Sortieren aus.

2) Klicken Sie auf die Symbole der aufsteigenden Sortierung oder absteigenden Sor-

tierung  auf der Standard-Symbolleiste.

Suchen und Ersetzen

Calc hat zwei Möglichkeiten innerhalb eines Dokuments Text zu finden: die Suchen-Symbolleiste
und den Suchen & Ersetzen Dialog.

Suchen-Symbolleiste
1) Gehen Sie in der Menüleiste zu Ansicht > Symbolleisten > Suchen, oder Sie gehen in 

der Menüleiste zu Bearbeiten > Suchen, bzw. verwenden die Tastenkombination Strg+F, 
um die Suchen-Symbolleiste zu öffnen (Abbildung 57). Standardmäßig ist die Suchen-Sym-
bolleiste in der untersten linken Ecke im Calc Fenster angedockt. Sie können die Symbol-
leiste abdocken und sie nach Ihrer Wahl verschieben. 

2) Schreiben Sie einen Suchbegriff in das Feld Suchen.

3) Wählen Sie Groß-/Kleinschreibung beachten, um Ihre Suche zu verfeinern. Zum Bei-
spiel, Ihr Suchbegriff ist Inhaber und die Auswahl Groß-/Kleinschreibung beachten wird 
nur Inhaber suchen und wird nicht Besitzer finden.

4) Klicken Sie auf die Nächsten suchen oder Vorherigen suchen Symbole. Um ande-
re Ereignisse desselben Begriffes zu finden, setzen Sie mit dem Anklicken auf die Symbole 
weiter fort. 
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Suchen & Ersetzen Dialog

Das Suchen

1) Gehen Sie in der Menüleiste auf Bearbeiten > Suchen & Ersetzen, oder Sie wenden das 
Tastenkürzel Strg+H an, oder Sie wählen auf der Suchen-Symbolleiste das Suchen & Er-

setzen Symbol , um den Suchen & Ersetzen Dialog zu öffnen (Abbildung 58).

2) Geben Sie die Suchkriterien ein oder wählen Sie die Suchkriterien in dem Feld Suche alle 
aus.

3) Gegebenenfalls klicken Sie auf Weitere Optionen, sodass Sie die Anzahl der Such-Filter 
erhöhen können, die Sie zu Ihrer Suche anwenden können.

4) Klicken Sie auf Suchen, um das erste Beispiel der Suchkriterien zu ermitteln, das Sie ein-
gegeben haben.

5) Klicken Sie nochmals auf Suchen, um das nächste Beispiel Ihrer Suchkriterien zu ermit-
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teln.

6) Klicken Sie auf Suche alle, um alle Beispiele Ihrer Suchkriterien zu ermitteln. Die Beispiele 
Ihrer Suchbegriffe werden in der Tabellenkalkulation hervorgehoben.

Das Ersetzen

1) Gehen Sie in der Menüleiste zu Bearbeiten > Suchen & Ersetzen, oder wenden das Tas-

tenkürzel Strg+H an, oder Sie wählen das Suchen & Ersetzen Symbol auf der Su-
chen-Symbolleiste, um den Dialog Suchen & Ersetzen zu öffnen (Abbildung 58).

2) Geben Sie die Suchkriterien ein oder Sie wählen sie im Feld Suche alle aus.

3) Geben Sie die Ersetzen-Kriterien ein oder Sie wählen sie im Feld Ersetze alle aus.

4) Gegebenenfalls klicken Sie auf Weitere Optionen, sodass Sie die Anzahl der Such-Filter 
erhöhen können, die Sie in Ihrem Suchen und Ersetzen anwenden können.

5) Klicken Sie auf Ersetzen, um das erste Beispiel der Suchkriterien zu ermitteln und um die-
se zu ersetzen, die Sie mit Ihren Ersatzkriterien eingegeben haben.

6) Klicken Sie noch einmal auf Ersetzen, um das nächste Beispiel der Suchkriterien zu ermit-
teln und zu ersetzen, die Sie mit Ihren Ersatzkriterien eingegeben haben.

7) Klicken Sie auf Ersetze alle, um alle Beispiele der Suchkriterien zu ermitteln und zu erset-
zen, die Sie mit Ihren Ersatzkriterien eingegeben haben.

Hinweis

Wenden Sie Ersetze alle mit Vorsicht an; andernfalls könnten Sie mit einigen hoch 
peinlichen Fehlern abschließen. Ein Fehler mit Ersetze alle erfordert zur Fehlerbe-
hebung eine manuelle, Wort-für-Wort-Suche, wenn es nicht rechtzeitig entdeckt 
wird, um es rückgängig zu machen.

Suchen & Ersetzen Optionen

Die verfügbaren Optionen, um Ihr Suchen und Ersetzen zu verfeinern sind wie folgt:

• Suche nach – geben Sie den Text ein, wonach Sie suchen möchten, oder wählen eine vor-
herige Suche von der Liste aus.

• Ersetzen durch – geben den Ersetzungstext ein, oder wählen einen kürzlichen Aus-
tauschtext oder Formatvorlage von der Liste aus.

• Groß-/Kleinschreibung – unterscheidet zwischen großgeschriebenen und kleingeschrie-
benen Zeichen.

• Nur ganze Zellen – sucht nach ganzen Wörtern oder Zellen, die dem Suchtext exakt ent-
sprechen.

• Nur in Selektion – durchsucht nur die ausgewählten Texte oder Zellen

• Rückwärts – die Suche verläuft ausgehend von der aktuellen Cursorposition rückwärts bis 
zum Dateianfang.

• Reguläre Ausdrücke – ermöglicht den Einsatz von Platzhaltern in der Suche. Weitere In-
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formationen zur Verwendung von regulären Ausdrücken finden Sie in der LibreOffice-Hilfe.

• Ähnlichkeitssuche – sucht nach Begriffen, die in der Suche nach Text, ähnlich sind. Wäh-
len Sie dieses Markierfeld, und klicken Sie dann auf die … Schaltfläche, um die Ähnlich-
keits-Optionen zu definieren.

• Suche nach Vorlagen – sucht nach formatiertem Text mit der Formatvorlage, die Sie fest-
gelegt haben. Wählen Sie diese Option und wählen Sie dann eine Vorlage aus der Suchen
nach Liste aus. Um eine Ersatzformatvorlage zu spezifizieren, wählen Sie eine Formatvor-
lage aus der “Ersetzen durch“ Liste.

• Zeichenbreite berücksichtigen – unterscheidet zwischen Zeichen halber und ganzer Brei-
te; nur verfügbar, wenn asiatische Sprachen aktiviert sind.

• Ähnliche Schreibweise (japanisch) – spezifizieren Sie die Suchoptionen für ähnliche Be-
zeichnung, die in japanischem Text benutzt wird. Wählen Sie diese Option, und klicken Sie 
dann auf die … Schaltfläche, um die Suchoptionen zu spezifizieren. Diese Option ist nur 
verfügbar, wenn asiatische Sprachen aktiviert sind.

• Suchen in – wählen Sie entweder Formeln, Werte, oder Notizen, um nach den Zeichen zu 
suchen, die Sie in den Ergebnissen von Formeln in Werte oder in Notizen angeben.

• Suchrichtung – bestimmt die Reihenfolge für die Durchsuchung der Zellen. 

• Suchen in alle Tabellen – durchsucht alle Tabellen in der aktuellen Tabellenkalkulation Da-
tei.
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